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 NOTE Notices
 +--- Note  -------------------------------------------------- ---------+
 ¦                                                                    ¦
 ¦ Before using this document, read the general info rmation under     ¦
 ¦ "Notices" in topic NOTICES .                                        ¦
 ¦                                                                    ¦
 +-------------------------------------------------- ------------------+
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 EDITION Edition Notice
First Edition (September 1994)

  
This edition applies to Version 2 Release 0 of the licensed program BookManager Library Reader for Windows, program number 

 5799-PXY, and to all subsequent releases and modifications until otherwise indicated in new editions.  Make sure you are using the 
 correct edition for the level of the product.
  

Order publications by phone or fax.  The IBM Software Manufacturing Company takes publication orders between 8:30 a.m. and 7:00 p.m. 
 eastern standard time (EST).  The phone number is (800) 879-2755.  The fax number is (800) 284-4721.
  

You can also order publications through your IBM representative or the IBM branch office serving your locality.  Publications are not 
 stocked at the address below.
  

A form for comments appears at the back of this publication.  If the form has been removed, address your comments to:
  
    IBM Corporation
    Department T45
    P.O. Box 60000
    Cary, NC 27512-9968
    USA
  

You can fax comments to (919) 469-7718.
  

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the information in any way it believes 
 appropriate without incurring any obligation to you.
  

Portions hereof Copyright ¦ ImageMark Software Labs , Inc. 1991-1993.   All rights reserved.   Included by permission.
  
 ¦ Copyright International Business Machines Corpora tion 1989, 1994.
 All rights reserved.

Note to U.S. Government Users -- Documentation related to restricted rights -- Use, duplication or disclosure is subject to restrictions set 
 forth in GSA ADP Schedule Contract with IBM Corp.
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 NOTICES Notices
  

References in this publication to IBM products, programs, or services do not imply that IBM intends to make these available in all countries 
 in which IBM operates.  Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, 
 program, or service may be used.  Any functionally equivalent product, program, or service that does not infringe any of the intellectual 
 property rights of IBM may be used instead of the IBM product, program, or service.  The evaluation and verification of operation in 
 conjunction with other products, except those expressly designated by IBM, are the responsibility of the user.
  
  

IBM may have patents or pending patent applications covering subject matter in this document.  The furnishing of this document does not 
 give you any license to these patents.  You can send license inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, 208 
 Harbor Drive, Stamford, CT, USA 06904-2501.
  

IBM may change this publication, the product described herein, or both. These changes will be incorporated in new editions of the 
 publication.
  
 Subtopics
 SOFTCOPY Softcopy Publications
 TRADEMARKS Trademarks
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 SOFTCOPY Softcopy Publications
  

For softcopy versions of this book, we authorize you to:
  

1.  Copy, modify, and print the documentation contained on the media, for use within your enterprise, provided you reproduce the copyright 
     notice, all warning statements, and other required statements on each copy or partial copy.
  

2.  Transfer the original unaltered copy of the documentation when you transfer the related IBM product (which may be either machines 
     you own, or programs, if the program's license terms permit a transfer). You must, at the same time, destroy all other copies of the 
     documentation.
  
  

You are responsible for payment of any taxes, including personal property taxes, resulting from this authorization.
  

THERE ARE NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE WARRANTIES OF MERCHANTABILITY AND FITNESS 
 FOR A PARTICULAR PURPOSE.
  

Some jurisdictions do not allow the exclusion of implied warranties, so the above exclusion may not apply to you.
  

Your failure to comply with the terms above terminates this authorization. Upon termination, you must destroy your machine readable 
 documentation.
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 TRADEMARKS Trademarks
  

The following terms, denoted by an asterisk (*) on their first occurrence in this publication, are trademarks of the IBM Corporation in the 
 United States or other countries:
  

    BookManager
     BookMaster
     IBM
     Operating System/2
     OS/2
  
  

The following terms, denoted by a double asterisk (**) on their first occurrence in this publication, are trademarks of other companies:
  

Adobe                           Adobe Systems Incorporated
 ImageStream Graphics Filters    ImageMark Software Labs, Inc.
 Microsoft                       Microsoft Corporation
 Windows                         Microsoft Corporation
 TrueType                        Apple Computer, Inc.
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 PREFACE About This Book
This book describes concepts related to the IBM* BookManager* Library Reader for Windows** licensed program--an application for 

 reading and using softcopy books.  You can use the application on a personal computer that runs:
  

Either:
  

    IBM OS/2 2.11 with WIN-OS/2 (1) installed
  

or
  

    Microsoft** Windows**Version 3.1
  

 (1) Running Library Reader for Windows in a full-screen WIN-OS/2     session is recommended.  If you run Library Reader for     
 Windows in a WIN-OS/2 window, you may find that your screen     occasionally does not repaint itself as completely or as     rapidly as 
 you would like.
  
 Subtopics
 WHO Who Should Use This Book
 HOW How to Use This Book
 WHERE Where to Find More Information
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 WHO Who Should Use This Book
  

This book is for anyone wanting conceptual information about BookManager Library Reader for Windows operations and terminology.
  

Note:   This book assumes that you already know how to use Microsoft Windows, and that you are comfortable performing such basic 
        Windows tasks as:
  

       �   Using Program Manager and File Manager
        �   Making a window active
        �   Maximizing, minimizing, and restoring windows
        �   Moving and sizing windows
        �   Using menu commands
        �   Using check boxes, option buttons, and command buttons
        �   Using scroll bars
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 HOW How to Use This Book
  

Use this book to learn about softcopy and BookManager Library Reader for Windows operations.
  

Available only in softcopy format with BookManager Library Reader for Windows, this book provides a reference for the key tasks 
 performed with Library Reader for Windows.  For your convenience, topics are arranged alphabetically for quick scanning and easy 
 retrieval of information. Should you wish to print information from this book, see "Printing Softcopy Information" in topic 36.0 for a list of 
 items that you can send to a printer.
  

 This book also contains many hypertext links--not only to related information within this book, but to related information in IBM 
 BookManager Library Reader for Windows: User's Guide and IBM BookManager Library Reader for Windows: Quick Reference.  For 
 example, notice that the preceding paragraph contains a highlighted (or emphasized) reference to a heading in this book.  Such 
 highlighting indicates a cross-reference link. If you placed your selection cursor on the highlighted heading and chose that heading (either 
 by double-clicking the heading or by pressing Enter), Library Reader for Windows would display that topic.  To return to this topic, you 
 could (for example) choose the Previous Topic icon from the tool bar.  For more information about linking to and from information in 
 softcopy books, see "Reading Softcopy Information" in topic 37.0.
  

Note:   For information on how to perform tasks in Library Reader for Windows, refer to IBM BookManager Library Reader for Windows: 
        User's Guide.  Also, online helps (specifically, Task Help) contain procedural information that is available to you whenever you are 
        using Library Reader for Windows.
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 WHERE Where to Find More Information
  

The following list shows where to find additional information about BookManager Library Reader for Windows:
  
�    IBM BookManager Library Reader for Windows: User's Guide--with a quick tour for getting started!, SC34-3065

  
�    IBM BookManager Library Reader for Windows: Quick Reference, SC34-3067

  
  

Because Library Reader for Windows uses the Microsoft Windows operating system, you might need publications that describe how to 
 use Microsoft Windows.  For a list of reference materials for Microsoft Windows and for IBM BookManager products, see "Bibliography" 
 in topic BIBLIOGRAPHY.
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 1.0 "As Is" Operators
  

As described in "Search Request" in topic 43.0, certain characters have specific functions when they appear in a search request.  
 Sometimes, however, one or more of those characters is part of the actual request. Assume, for example, an ampersand (&) is part of 
 your search request.  To prevent BookManager Library Reader for Windows from treating the ampersand as a Boolean operator, enclose 
 the ampersand in "as is" operators (also known as escape operators).
  

Single quotes are Library Reader for Windows' "as is" operators.  Table 1 shows some examples of search requests using "as is" 
 operators.
  
 +-------------------------------------------------- ----------------------+
 ¦ Table 1. Examples of "As Is" Operators in Search Requests              ¦
 +-------------------------------------------------- ----------------------¦
 ¦ Use this expression:           ¦ To:                                     ¦
 +-------------------------------+------------------ ----------------------¦
 ¦ cat '&' dog                    ¦ Prevent the ampersand from bei ng       ¦
 ¦                               ¦ treated as a Bool ean and  character:    ¦
 ¦                               ¦                                        ¦
 ¦                               ¦ �   cat & dog  is an exact match .       ¦
 ¦                               ¦ �   cats & dogs  is a fuzzy match .      ¦
 ¦                               ¦ �   Cat & Dog  is both an exact match   ¦
 ¦                               ¦     (without case sensitivity ) and a   ¦
 ¦                               ¦     fuzzy match.                       ¦
 ¦                               ¦ �   cat and dog  is not a match.        ¦
 +-------------------------------+------------------ ----------------------¦
 ¦ Super'*'Pooch                  ¦ Prevent the asterisk from being        ¦
 ¦                               ¦ treated as a wildcard  character:       ¦
 ¦                               ¦                                        ¦
 ¦                               ¦ �   Super*Pooch  is a match.            ¦
 ¦                               ¦ �   SuperPooch  is not a match.         ¦
 +-------------------------------+------------------ ----------------------¦
 ¦ Canine Kennel Club '('CKC')'   ¦ Prevent the parentheses from being     ¦
 ¦                               ¦ treated as grouping operators :         ¦
 ¦                               ¦                                        ¦
 ¦                               ¦ �   Canine Kennel Club (CKC)  is a      ¦
 ¦                               ¦     match.                             ¦
 +-------------------------------+------------------ ----------------------¦
 ¦ kitten''s fur                  ¦ Prevent the single quote from be ing    ¦
 ¦                               ¦ treated as an "as is" operator :        ¦
 ¦                               ¦                                        ¦
 ¦                               ¦ �   kitten's fur  is a match.           ¦
 +-------------------------------------------------- ----------------------¦
 ¦ Note:   Notice that, when a single-quote (or apostrophe) character is   ¦
 ¦ part of a search request, you must not enclose it  in "as is"           ¦
 ¦ operators.  The two single quotes side by side te ll Library Reader for ¦
 ¦ Windows that a single quote is included in the re quest.                ¦
 +-------------------------------------------------- ----------------------+
  

Note:   Extended search dialog boxes provide buttons that, when chosen, insert operators (including "as is" operators) into the Search 
        Request text box.  You complete the search request by typing the words or phrases into the text box.  For more information about the 
        buttons and how they relate to the insertion point, refer to the User's Guide.
  
  

Related Topics:
  

       In this book:
  

           "Word or Phrase Separator" in topic 63.0
            "Wildcard Characters" in topic 60.0
            "Boolean Operators" in topic 10.0
            "Grouping Operators" in topic 18.0
            "Type of Search" in topic 55.0
  

       In the User's Guide:
  

           Procedures for searching for special symbols
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 2.0 Book Description Window
  

The Book Description window displays additional information about the book you are viewing:
  
�   Book Title

 �   Copyright or Security Classification
 �   Document Number
 �   Authors
 �   Date Published, Date Built, and Version of BUILD
 �   File Name
  

To view book descriptions, choose the Book Description command in the File menu of any of the following:
  
�   Book window

 �   Bookshelf window
 �   List of Books window
  

For an illustration of a sample Book Description window and detailed explanations of its components, refer to the User's Guide.
  

Related Topics:
  

       In this book:
  

           "Bookshelf Description Window" in topic 6.0
  

       In the User's Guide:
  

           Procedures for getting a book description
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 3.0 Book Window
  

One of BookManager Library Reader for Windows' startup windows, the Book window displays a book's text.  Use the Book window to 
 read and search for information in a book.
  

You can access this window from any of the following:
  
�   Bookshelf window

 �   List of Books window
 �   List of Bookshelves window
  

To access the Book window directly at startup, choose the icon for a book from Windows File Manager.  You can also access the Book 
 window at startup from either Program Manager or File Manager by using the Windows Run command; in this case, you would type a 
 command that specifies the desired book.  For example:
  

READIBM  bookname
        Opens the named book if found in the default startup path.
  

       Note:   If a bookshelf exists with the same name as the book, Library Reader for Windows opens the bookshelf instead of the book.
  

READIBM  bookname /b
        Opens the named book when both a bookshelf and a book in the default startup path share the same name.
  

READIBM  bookname.BOO
        Opens the named book if found in the default startup path.
  

READIBM \path\bookname.BOO
        Opens the named book if found in the specified path and temporarily appends that path to the front of the startup path.
  

READIBM  bookname /f search request
        Opens the named book and searches for the words or phrases specified in the search request.
  

       Note:   If you do not type a search request, the Search Book or Search Book (Extended) dialog box appears.
  
  

For a complete list of startup commands, see Figure 2 in topic 50.0.
  

In the Book window, you can choose from these menus:
  
�   File, from which you view the book's description and perform various printing functions

  
�   Edit, from which you copy text to the Clipboard and place or remove bookmarks

  
�   View, from which you activate or deactivate the tool bar and the status bar, as well as request that pictures display in the text

  
�   Navigate, from which you access a variety of navigator windows or go directly to specific areas in the book

  
�   Search, from which you request a search, display search results, or navigate among search results

  
�   Notes, from which you create, list, or delete notes about the book

  
�   Options, from which you set profile options to make permanent changes to the Library Reader for Windows application

  
�   Window, from which you either close all windows listed as open or access one of them

  
�   Help, from which you access various types of online help for Library Reader for Windows

  
  

For an illustration of a sample Book window and detailed explanations of its components, refer to the User's Guide.
  

Related Topics:
  

       In this book:
  

           "Startup Windows" in topic 52.0
            "Starting BookManager Library Reader for Windows" in topic 50.0
            "Reading Softcopy Information" in topic 37.0
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 4.0 BookManager
  

BookManager consists of two sets of products that work together: BookManager BUILD and BookManager Library Reader.
  

BookManager BUILD products create softcopy documents from various types of source files created in either a workstation environment 
 or a host environment.  Word processor source files that use styles or host source files that use markup tags (2) make a softcopy book 
 more useful by giving it greater format flexibility and search capability.  The styles or markup tags organize the softcopy information into 
 topics and subtopics, whose content and length are determined by the author.
  

BookManager Library Reader products serve as softcopy viewers; they provide the capabilities for reading, navigating, and searching 
 through softcopy documents created by BookManager BUILD.  The documents can be created at your company or supplied by another 
 company, such as IBM or some other software vendor.
  

Note:   Under most circumstances, any softcopy document built with any BookManager BUILD product can be read with any 
        BookManager Library Reader product. (3)
  
  

The following products make up the IBM BookManager family:
  
�   IBM BookManager BUILD/2

 �   IBM BookManager BUILD/MVS
 �   IBM BookManager BUILD/VM
 �   IBM BookManager READ/2
 �   IBM BookManager READ/6000
 �   IBM BookManager READ/DOS
 �   IBM BookManager READ for Windows.
 �   IBM BookManager READ/MVS
 �   IBM BookManager READ/VM
  
  

If you are interested in learning about the BookManager product family, refer to Writing Softcopy for BookManager, SC22-0011. (4)
  

Related Topics:
  

       In this book:
  

           "Softcopy" in topic 48.0
  
  (2)  The source-file  author uses a document markup language
     application--such as  IBM BookMaster*  (program number
     5688-015)--to create markup tags.
  
  (3) Library Reader for Windows cannot read books b uilt using a
     BookManager BUILD 1.0 or 1.1 product.
  
  (4) Order publications by phone or fax.  The IBM S oftware
     Manufacturing Company takes publication orders between
     8:30 a.m. and 7:00 p.m. eastern standard time ( EST).  The
     phone number is (800) 879-2755.  The fax number  is
     (800) 284-4721.
  

    You can also order publications through your IBM representative or the IBM branch office serving your locality.
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 5.0 Bookmarks
  

Just as you might use a bookmark in a printed book, you can place a bookmark in a softcopy book.
  
  

    To place a bookmark, choose the Place Bookmark command from the Edit menu.
  

    To return to the bookmark, choose the Go to Bookmark command from the Navigate menu.
  

    To delete the bookmark, choose the Remove Bookmark command from the Edit menu.
  
  

If you close a book without removing the bookmark, when you return to the book it will automatically open to the topic containing the 
 bookmark.
  

Note:   A softcopy book can contain only one bookmark.
  
  

Related Topics:
  

       In the User's Guide:
  

           Procedures for using the bookmark
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 6.0 Bookshelf Description Window
  

Accessed by choosing the Bookshelf Description command in the List of Bookshelves window's File menu, the Bookshelf Description 
 window displays additional information about the bookshelf you are viewing:
  
�   Bookshelf Title

 �   Bookshelf Name
 �   Search Index
 �   Total Books
 �   Unindexed Books
 �   Date Created
 �   Your Access
 �   File Name
  

For an illustration of a sample Bookshelf Description window and detailed explanations of its components, refer to the User's Guide.
  

Related Topics:
  

       In this book:
  

           "Book Description Window" in topic 2.0
  

       In the User's Guide:
  

           Procedures for getting a bookshelf description
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 7.0 Bookshelf Search Index
  

BookManager Library Reader for Windows uses a bookshelf search index to increase the speed with which a multiple-book search is 
 performed on a bookshelf.  A bookshelf search index contains all the words in all the books on the bookshelf for which the search index 
 was created.
  

Bookshelves created using Library Reader for Windows will not have a search index.  Bookshelf search indexes are created using either 
 BookManager BUILD/MVS or BookManager BUILD/VM.  However, prebuilt bookshelves that you acquire from IBM or other sources may 
 come with search indexes.  Library Reader for Windows, for example, provides a search index for use with the bookshelf containing its 
 documentation.
  

Unlike the "back-of-the-book" index you see in the Index navigator, a bookshelf search index cannot be displayed--Library Reader for 
 Windows uses it only when searching the bookshelf.  A back-of-the-book index is independent from a bookshelf search index; if your book 
 has one, it does not necessarily have the other.
  

Sometimes a book can be part of a bookshelf and yet not have its words included in the bookshelf search index.  This situation occurs 
 when you add a book to a bookshelf after its search index already exists. (5) The situation does not prevent the newly-added book from 
 being searched during a multiple-book search; however, it does mean that the multiple-book search will run more slowly (because the 
 search includes an unindexed book).
  

Conversely, a bookshelf search index can include books that are not stored on your computer or in any directory to which you have 
 access on a LAN. That situation occurs when prebuilt bookshelves are given to you by someone else who has access to different books.  
 The bookshelf search index makes it possible for you to search the words of a book that you do not have, if they were included in the 
 search index.  However, you would have to acquire the .BOO file for that book if you wanted to open and use it.
  

A bookshelf and its search index are in separate files that usually have the same file name but different file extensions.  The extension for a 
 bookshelf is .BKS; for the search index, it is .BKI.  When a bookshelf has a search index associated with it, the name of the index can be 
 seen in the Search Index text box on the Bookshelf Description dialog box.
  

Related Topics:
  

       In this book:
  

           "Bookshelves" in topic 9.0
            "File Extensions" in topic 14.0
  
  (5) Icons for unindexed books differ from those fo r books
     included in the search index.
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 8.0 Bookshelf Window
  

One of BookManager Library Reader for Windows' startup windows, the Bookshelf window displays the books contained on a bookshelf.  
 A search index may accompany the bookshelf; however, the search index may not include all books on the bookshelf.
  

You can access this window by choosing a bookshelf from the List of Bookshelves window.
  

To access the Bookshelf window directly at startup, choose the icon for a bookshelf from Windows File Manager.  You can also access 
 the Bookshelf window at startup from either Program Manager or File Manager by using the Windows Run command; in this case, you 
 would type a command that specifies the desired bookshelf.  For example:
  

READIBM  shelfname
        Opens the named bookshelf if found in the default startup path.
  

       Note:   If the named bookshelf can't be found and a book with the same name exists, Library Reader for Windows opens the book 
               instead.
  

READIBM  shelfname /s
        Opens the named bookshelf when both a bookshelf and a book in the default startup path share the same name.
  

READIBM  shelfname.BKS
        Opens the named bookshelf if found in the default startup path.
  

READIBM \path\shelfname.BKS
        Opens the named bookshelf if found in the specified path and temporarily appends that path to the front of the startup path.
  

READIBM  shelfname /f search request
        Opens the named bookshelf and searches for the words or phrases specified in the search request.
  

       Note:   If you do not type a search request, the Search Multiple Books or Search Multiple Books (Extended) dialog box appears.
  
  

For a complete list of startup commands, see Figure 2 in topic 50.0.
  

In the Bookshelf window, you can choose from these menus:
  
�   File, from which you can:

  
    -   View a book's description

     -   Create a bookshelf
     -   Add books to or remove them from bookshelves
     -   Reopen a book that is already open (for example, to view a figure while you read its accompanying text)
  
�   Edit, from which you select or deselect books on the bookshelf for performing tasks available on the Bookshelf window

  
�   View, from which you activate or deactivate the status bar, as well as:

  
    -   Include or exclude books listed on the bookshelf

     -   Sort the contents of the bookshelf
     -   Refresh the Bookshelf window
  
�   Search, from which you request a search of books on the bookshelf and display search results

  
�   Options, from which you set profile options to make permanent changes to the BookManager Library Reader for Windows application

  
�   Window, from which you either close all windows listed as open or access one of them

  
�   Help, from which you access various types of online help for Library Reader for Windows

  
  

For an illustration of a sample Bookshelf window and detailed explanations of its components, refer to the User's Guide.
  

Related Topics:
  

       In this book:
  

           "Bookshelf Search Index" in topic 7.0
            "Startup Paths" in topic 51.0
            "Startup Windows" in topic 52.0
            "Starting BookManager Library Reader for Windows" in topic 50.0
  

       In the User's Guide:
  

           Procedures for opening a book
            Procedures for creating and maintaining bookshelves
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 9.0 Bookshelves
  

BookManager provides electronic bookshelves as a way to group similar books, to help you find and search them easily.  For example, 
 you might create one bookshelf for all the books on a particular subject and another bookshelf for books that you use most often.  You can 
 give bookshelves easy-to-remember names that remind you of their contents.  Also, you can quickly search all the books in a bookshelf for 
 the same word or phrase.
  

A bookshelf does not actually contain the softcopy books assigned to it; instead, it contains:
  
�   The file names for each book on the bookshelf

 �   A description of the bookshelf's contents
 �   The title of each book on the bookshelf
 �   The date each book was built using BookManager BUILD
 �   The name of the bookshelf search index, if one exists
  

When Library Reader for Windows starts, it typically lists (from the startup path) all the bookshelves available to you, and you pick the one 
 you want to read.  However, if there is one particular bookshelf you work with frequently, you can have Library Reader for Windows open 
 to that bookshelf automatically.  (See "Starting BookManager Library Reader for Windows" in topic 50.0 for information on startup options.)
  

Use bookshelves whenever possible--they help you keep similar books together so you can find or search them quickly.
  

Related Topics:
  

       In this book:
  

           "List of Bookshelves Window" in topic 23.0
            "Bookshelf Window" in topic 8.0
            "Bookshelf Search Index" in topic 7.0
            "Startup Paths" in topic 51.0
  

       In the User's Guide:
  

           Procedures for opening a bookshelf
            Procedures for creating and maintaining bookshelves

BookManager Library Reader for Windows: Online Refe rence
Bookshelves

¦ Copyright IBM Corp. 1989, 1994
9.0 - 1



 10.0 Boolean Operators
  

The term Boolean refers to a method that establishes a relationship between items combined in a statement, with the result taking on one 
 of two values.  Boolean operators let you combine two words (or phrases) that you want to use in a search request.  BookManager 
 Library Reader for Windows uses this combined statement as criteria for determining whether an item is a search match.
  

Library Reader for Windows offers three Boolean operators for combining words and phrases so that you can broaden or narrow the 
 results of your search request:
  
  
�   &, which represents and and specifies that both words (or phrases) must be present for a topic to qualify as a search match

  
�   |, which represents or and specifies that either word (or phrase) must be present for a topic to qualify as a search match

  
�   !, which represents but not and specifies that the first word (or phrase) must be present, but that the second word (or phrase) must 

     not be present for a topic to qualify as a search match
  
  
 Table 2  provides some examples that show you how to create  simple
 expressions using Boolean operators.
  
 +-------------------------------------------------- ----------------------+
 ¦ Table 2. Examples of Simple Boolean Expressions                        ¦
 +-------------------------------------------------- ----------------------¦
 ¦ Use this expression:  ¦ To find:                                         ¦
 +----------------------+--------------------------- ----------------------¦
 ¦ lions & tigers        ¦ Topics that contain both the word lions  and the ¦
 ¦                      ¦ word tigers                                      ¦
 +----------------------+--------------------------- ----------------------¦
 ¦ cat | dog             ¦ Topics that contain either the word cat  or the  ¦
 ¦                      ¦ word dog                                         ¦
 +----------------------+--------------------------- ----------------------¦
 ¦ opossum ! sleep       ¦ Topics that contain the word opossum  but not    ¦
 ¦                      ¦ the word sleep                                   ¦
 ¦                      ¦                                                 ¦
 ¦                      ¦ You could use this express ion, for example, if  ¦
 ¦                      ¦ you want to find informati on about opossums,    ¦
 ¦                      ¦ but you do not want inform ation about their     ¦
 ¦                      ¦ sleeping habits.                                ¦
 +-------------------------------------------------- ----------------------+
  

When you use Boolean operators, Library Reader for Windows searches an entire topic for the absence or presence of the words that 
 you specify. For example, if you type lions & tigers , Library Reader for Windows considers a topic to be a match even if the first word in 
 the topic is tigers, but the word lions does not appear until the end of the topic.
  

Note:   Extended search dialog boxes provide buttons that, when chosen, insert operators (including Boolean operators) into the Search 
        Request text box.  You complete the search request by typing the words or phrases into the text box.  For more information about the 
        buttons and how they relate to the insertion point, refer to the User's Guide.
  

You can use other types of operators to create more complex Boolean expressions.  For example:
  
�   Parentheses are grouping operators that change the order of precedence.

  
        (elephants | tigers | lions) & (zoo | circus)

  
  
�   Single quotes are "as is" operators that prevent Library Reader for Windows from treating a character as an operator.  For example, if 

     a character that represents a Boolean operator is part of your search request, enclose that character in single quotes.
  

        Scat'!' | cat '&' mouse
  
  
  

A Boolean expression can also contain word or phrase separators and wildcard characters.  For more information about combining 
 operators in a search request, see "Search Request" in topic 43.0.
  

Note:   A Boolean expression can contain up to 64 words or phrases and cannot exceed 255 characters.  For more information about 
        search request limits and restrictions, refer to the User's Guide.
  
  

Related Topics:
  

       In this book:
  

           ""As Is" Operators" in topic 1.0
            "Word or Phrase Separator" in topic 63.0
            "Wildcard Characters" in topic 60.0
            "Grouping Operators" in topic 18.0
            "Search Results Ranking" in topic 45.0
  

       In the User's Guide:
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           Procedures for combining search words using Boolean operators

            Procedures for using command buttons to enter Boolean operators and symbols
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 11.0 Edit Menus
  

Table 3 compares the various Library Reader for Windows Edit menus. Notice that commands available on an Edit menu vary, depending 
 on where you are in the application.  For all menu commands, Library Reader for Windows offers:
  
�   Context-sensitive help, which describes the purpose and use of the command

  
�   Short help, which displays (in the status bar) a one-line description of the command

  
  
  
 Table 3. Comparison of Edit Menus
 from List of Books                             from Bookshelf
  
 Edit                                          Edit
     Select All                /                   Select All                /
     Deselect All              \                   Deselect All              \
     Select Only Books with Search Matches         Select Only Books with Search Matches
  
 from Book                                      from Picture
  
 Edit                                          Edit
     Copy                 Ctrl+C                   Copy          Ctrl+C
     Place Bookmark
     Remove Bookmark
     --------------------------------
     Select All           Ctrl+/
     Deselect All         Ctrl+\
  
 from Topics                                    from Search Results
  
 Edit                                          Edit
     Select All                                    Select All
     Deselect All                                  Deselect All
  
 from Topics-Seen                               from Notes List
  
 Edit                                          Edit
     Select All                                    Select All
     Deselect All                                  Deselect All
     ------------------------------------
     Clear
  
 from Revisions
  
 Edit
     Select All
     Deselect All
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 12.0 Exiting BookManager Library Reader for Windows
  

Unless otherwise specified in your user profile, an exit-confirmation dialog box appears when you exit Library Reader for Windows from 
 the List of Bookshelves window.  This dialog box verifies that you want to close all windows and exit Library Reader for Windows.  To 
 continue the exit process, choose the OK button.  To discontinue the exit process and remove the dialog box, choose the Cancel button.
  

Note:   The exit-confirmation dialog box appears only when exiting Library Reader for Windows from the List of Bookshelves window.  If you 
        entered a Bookshelf window or Book window directly (through startup options), a confirmation dialog box does not appear when you 
        exit Library Reader for Windows.
  

For information on permanently disabling this exit-confirmation dialog box, see "Options Menus" in topic 30.0.
  

Related Topics:
  

       In the User's Guide:
  

           Procedures for closing and exiting Library Reader for Windows

BookManager Library Reader for Windows: Online Refe rence
Exiting BookManager Library Reader for Windows

¦ Copyright IBM Corp. 1989, 1994
12.0 - 1



 13.0 Extended Searches
  

To temporarily change search options or to use additional search capabilities, choose the Extended button from either the Search Book 
 dialog box or the Search Multiple Books dialog box.  An extended search dialog box appears:  either Search Book (Extended) or Search 
 Multiple Books (Extended).
  

Similar to basic search dialog boxes, extended search dialog boxes offer the ability to use options from prior search requests.  
 BookManager Library Reader for Windows saves prior search requests and their options during a window session.  Choose Retrieve 
 Previous Searches to display prior search requests and simultaneously retrieve their associated search options.  Selecting a prior 
 request selects its search options and displays its text in the Search Request box.  (Simply type over the text to enter a different request 
 and use the same options.)
  

Extended search dialog boxes offer greater search capabilities than basic Search dialog boxes.  For example, you can:
  
�   Select buttons that insert operators like Boolean operators and wildcard characters into your search request

  
�   Specify that spelling variations be included in the search

  
�   In a book search, specify an exact-match search or a fuzzy-match search

  
�   In a book search, specify the scope of the search, including:

  
    -   Topic Titles

     -   Topic Text
     -   Indexed Words
  
�   In a book search, view search matches in different ways, including:

  
    -   In a Search Results navigator or at search matches in the book

     -   Ordered by importance or ordered sequentially
  
  

Note:   If you do not change search options, Library Reader for Windows uses defaults stored in your user profile.  Use the Options menu 
        (from the Book, Bookshelf, or List of Bookshelves windows) to permanently change default search options in your profile.
  
  

Related Topics:
  

       In this book:
  

           "Boolean Operators" in topic 10.0
            "Wildcard Characters" in topic 60.0
            "Word Check" in topic 62.0
            "Type of Search" in topic 55.0
            "Where to Search" in topic 59.0
            "Search Request" in topic 43.0
            "How to Show Results" in topic 20.0
            "Search Results Ranking" in topic 45.0
            "Options Menus" in topic 30.0
            "Search Menus" in topic 42.0
  

       In the User's Guide:
  

           Procedures for using an extended search dialog box
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 14.0 File Extensions
  

BookManager Library Reader for Windows uses the following file extensions:
  
�   .BOO for book files

 �   .BKS for bookshelf files
 �   .BKI for bookshelf search index files
 �   .NTF for book notes files (6)
  

Note:   During installation, Library Reader for Windows creates file associations to book (.BOO) files and bookshelf (.BKS) files. These file 
        associations let you open directly to a book or bookshelf from Windows File Manager at startup.
  
  

Related Topics:
  

       In this book:
  

           "Starting BookManager Library Reader for Windows" in topic 50.0
  
  (6) .NTF is the default extension for files contai ning  notes  on
     books.  For information about notes files, see "Notes" in
     topic 28.0 .
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 15.0 File Menus
  

Table 4 compares the various Library Reader for Windows File menus. Notice that commands available on a File menu vary, depending 
 on where you are in the application.  For all menu commands, Library Reader for Windows offers:
  
�   Context-sensitive help, which describes the purpose and use of the command

  
�   Short help, which displays (in the status bar) a one-line description of the command

  
  
  
 Table 4. Comparison of File Menus
 from List of Bookshelves                           from List of Books
  
 File                                              File
     Open Book...             Ctrl+O                   Bo ok Description... Ctrl+D
     Open Bookshelf...        Ctrl+Shift+O
                                                       -----------------------------------------
     ---------------------------------------           C r eate Bookshelf...
     List Books...            Ctrl+B                   Ad d Selected Books to Another Bookshelf...
     List Book shelves...      Ctrl+Shift+B
                                                       -----------------------------------------
     ---------------------------------------           Ope n Again
     Bookshelf Description... Ctrl+D
     C r eate Bookshelf...                               --- --------------------------------------
                                                       Close
     ---------------------------------------
     Ope n Again
     ---------------------------------------
     E x it
  
 from Bookshelf                                     from Book
  
 File                                              File
     Book Description...       Ctrl+D                  Open...                   Ctrl+O
     -----------------------------------------         ----------------------------------------
     C r eate Bookshelf...                               Boo k Description...       Ctrl+D
     Add Other Books to This Bookshelf...
     Add Selected Books to Another Bookshelf...        ------ ----------------------------------
     Re move Selected Books from This Bookshelf         Print...                  Ctrl+P
                                                       Print Selected Topics...  Ctrl+Shift+P
     -----------------------------------------         Print Marked Text...
     Ope n Again                                        Print  Pre v iew...
                                                       P r int Setup...
     -----------------------------------------
     Close                                             -- --------------------------------------
                                                       Close
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 16.0 Fonts
Your choice of fonts determines how well BookManager Library Reader for Windows displays softcopy information.  Although Library 

 Reader for Windows can use any font that you have installed on your system, the application works best with a scalable font.  Scalable 
 fonts not only provide the best alignment of softcopy columnar tables, they also provide the best print results.  Examples of scalable fonts 
 are TrueType** Courier New (or any other monospaced TrueType font) and Adobe** Type I fixed fonts.  At installation, Library Reader for 
 Windows automatically uses TrueType fonts if they are installed on your system. (7)
  

Note:   If your system does not have a scalable font installed, Library Reader for Windows uses a nonscalable font.  However, be aware 
        that the displaying (or printing) of softcopy text may be less than optimal.
  
  

Windows uses the ANSI character set for most of its fonts, including the TrueType fonts.  BookManager softcopy books, however, use 
 the OEM character set.  Occasionally, the two character sets do not agree, causing an inaccurate representation of some special 
 characters (for example, round bullets, umlaut letters, and the cent symbol).  If you discover that some special characters do not display 
 as you would like, try using an OEM font for displaying softcopy.  Terminal and 8514OEM are examples of OEM fonts.  Be aware, 
 however, that these OEM fonts are not scalable and may not be well suited for tables. (8)
  

Note:   As explained in "Reflow" in topic 38.0, Library Reader for Windows treats tables as nonreflowable text--line widths remain the 
        same, regardless of the margins provided.  Although you can change fonts and font sizes, Library Reader for Windows allows only 
        monospaced fonts for displaying nonreflowable text.  Depending on the character sets needed for a particular softcopy book to display 
        properly, you might find that mixing font types best suits your needs (for example, a TrueType proportional font for reflowable text and 
        an OEM monospaced font for nonreflowable text).
  

       Library Reader for Windows treats the following document elements as reflowable and can display them either in a proportional font or 
        a monospaced font:
  
  

       �   Paragraphs, including highlighted phrases and most hypertext links (9)
  

       �   Lists--simple lists, ordered (numbered) lists, unordered (bulleted) lists, and definition lists like those used in glossaries and 
            dictionaries
  

       �   Footnotes, quotes, and other paragraph-like elements that frequently use indentation
  
  
  

       Library Reader for Windows treats the following document elements as nonreflowable and displays them only in a monospaced font:
  

       �   Tables
        �   Figures (10)
        �   Examples
        �   Syntax diagrams
        �   Right-justified text
        �   Front-matter contents listings--tables of contents, lists of figures, and lists of tables
        �   Lists of subtopics at the end of topics
        �   Topic titles (headings)
        �   Indexes
  
  
  

If you want to change the default fonts for either reflowable text or nonreflowable text, use the Options menu to permanently update your 
 user profile.
  

Note:   Existing books built without reflow support (using BUILD 1.2) display as nonreflowable--they display in a monospaced font.  To find 
        out the version of BUILD used to build the book you are viewing, choose the Book Description command in the File menu.
  
  

Related Topics:
  

       In this book:
  

           "Reflow" in topic 38.0
            "User Profile" in topic 57.0
  

       In the User's Guide:
  

           Procedures for changing fonts
  
  (7) The first time you use Library Reader for Wind ows, it looks
     for a TrueType font and, if it finds one, conti nues to use
     that font until you select a different one.  If  you select a
     different font, Library Reader for Windows cont inues to use
     it until you change it again.
  

    If Library Reader for Windows cannot find the most recently selected font (for example, if the font was deleted from your system), 
     Library Reader for Windows substitutes a font that is most similar to the one you selected last.  When deciding what to substitute, 
     Library Reader for Windows gives priority to TrueType fonts if they are available.
  
  (8) Some highlighting (for example, boldface or it alics) in the
     source file  causes misalignment of borders when that
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     highlighting occurs within a table and is displ ayed in an OEM
     font.
  
  (9) Hypertext links to pictures are not reflowable ; they display
     on a line by themselves.
  
  (10) Integrated pictures  are not reflowable; they display on a
     line by themselves.
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 17.0 Go to Matches in Book Text
  

If you select Go to Matches in Book Text in a search request, BookManager Library Reader for Windows bypasses the Search Results 
 navigator and takes you directly to search matches in the book.  When you are at a search match within the book, you can move from one 
 search match to another using either the Next Match icon and the Previous Match icon or the Go to Next Match command and the Go to 
 Previous Match command on the Search menu.
  

Note:   The Go to Matches in Book Text option applies only to a book search.  (BookManager Library Reader for Windows always lists 
        multiple-book search results by importance in a Multiple-Book Search Results navigator.)  To change the option temporarily, select 
        Go to Matches in Book Text (located in the How to Show Results area of the Search Book (Extended) window).  For information 
        about permanently changing search options, see "Options Menus" in topic 30.0.
  
  

Related Topics:
  

       In this book:
  

           "Search Request" in topic 43.0
            "How to Show Results" in topic 20.0
            "List Topics by Importance" in topic 24.0
            "List Topics in Sequence" in topic 25.0
            "Extended Searches" in topic 13.0
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 18.0 Grouping Operators
  

Boolean operators in a search request use a default order of precedence:
  

1.  !, which represents but not, takes precedence over and.
 2.  &, which represents and, takes precedence over or.
 3.  |, which represents or, has the lowest priority of the three Boolean operators.
  

To change the default order of precedence, you would use grouping operators to enclose words and phrases in your search request. 
 Parentheses are Library Reader for Windows' grouping operators.  To demonstrate, examine the following search request:
  

    rabbit | goat & vegetable !   garden
  
  

Using the default order of precedence, Library Reader for Windows would first search for topics containing the word vegetable, and only 
 those topics without the word garden would be considered for the remainder of the search.  From this first set of topics, Library Reader 
 for Windows would search for goat; topics containing both goat and vegetable would qualify as matches.  From this next set of topics, 
 Library Reader for Windows would search for topics containing either rabbit or both goat and vegetable.
  

However, suppose that you want Library Reader for Windows to search first for topics containing either rabbit or goat and, from the 
 matches obtained, continue to search for topics containing vegetable but not garden.  In other words you want to assign precedence to 
 the "or part" of the expression.  To do this, you would use grouping operators in your search request:
  
  

    (rabbit | goat) & vegetable ! garden
  
  

Note:   Extended search dialog boxes provide buttons that, when chosen, insert operators (including grouping operators) into the Search 
        Request text box.  You complete the search request by typing the words or phrases into the text box.  For more information about the 
        buttons and how they relate to the insertion point, refer to the User's Guide.
  
  

Related Topics:
  

       In this book:
  

           "Word or Phrase Separator" in topic 63.0
            "Wildcard Characters" in topic 60.0
            "Boolean Operators" in topic 10.0
            ""As Is" Operators" in topic 1.0
            "Search Results Ranking" in topic 45.0
  

       In the User's Guide:
  

           Procedures for combining search words using Boolean operators
            Procedures for using command buttons to enter Boolean operators and symbols
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 19.0 Help Menus
  

As shown in Table 5, BookManager Library Reader for Windows displays the same Help menu when you choose Help on the menu 
 bar--regardless of where you are in the application.
  
 Table 5. Help Menu
 from List of Bookshelves , List of Books , Bookshelf , Book , Picture , Topics ,
 Search Results , Topics-Seen , Notes List , or Revisions
  
 Help
     Help I ndex
     --------
     How to Use Help
     Contents
     Task Help
     Keys Help
     --------
     User's Guide
     About...
  
  

All Help menus provide the following types of online help:
  
  

Help  Index
        When you choose Help Index, an Index navigator appears that lists all indexed help topics.  Choosing an item from the index links you 
        to that topic in the online help.
  

How to Use Help
        When you choose How to Use Help, procedures for using Microsoft Windows' online help system appear.
  

Contents
        When you choose Contents, a general description of a window's purpose and use appears. (11)
  

Task Help
        When you choose Task Help, a navigator appears that lists tasks you can perform using Library Reader for Windows.  Choosing an 
        item from the list links you to the help--usually a procedure--for performing the task.
  

Keys Help
        When you choose Keys Help, a list of shortcut keys and their definitions appears.
  

User's Guide
        When you choose User's Guide, IBM BookManager Library Reader for Windows: User's Guide opens, from which you can choose a 
        topic or type in a search request to learn about Library Reader for Windows.
  

About
        When you choose About, a product-information screen appears.  It contains such items as:
  

       �   Product name
        �   Program number
        �   Version and release
        �   Copyright information
        �   Service level (updated whenever Library Reader for Windows is serviced)
  
  

Note:   Library Reader for Windows offers two additional types of help beyond what is available from the Help menu:
  

       �   Context-sensitive help, which describes the purpose and use of:
  

           -   Menu commands in any of the following:
  

               -   List of Bookshelves window
                -   List of Books window
                -   Bookshelf window
                -   Book window
                -   Picture window
  

           -   Tool bar icons in the Book window
  
  
  

       �   Short help, which displays in the status bar and provides a one-line description of:
  

           -   Menu commands in any of the following:
  

               -   List of Bookshelves window
                -   List of Books window
                -   Bookshelf window
                -   Book window
                -   Picture window
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           -   Tool bar icons in the Book window

  
  
  
  
  

Related Topics:
  

       In the User's Guide:
  

           Procedures for getting help
  
  (11) The window described is not necessarily the  active window
     and frequently depends on the  startup window  used.  Refer to
     the User's Guide  for detailed information about the types of
     contents help and how to get them.
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 20.0 How to Show Results
  

At the conclusion of a search request, BookManager Library Reader for Windows (using defaults) displays a list of topics containing 
 search matches in a Search Results navigator.  Topics are listed by their "importance"--with the best search matches preceding topics 
 with lesser matches--using the following ranking:
  

1.  Index entries
 2.  Topic titles
 3.  Topic text
  

However, when searching a book, you might prefer having topics listed in sequence.  (This method is faster because Library Reader for 
 Windows does not rank results and sort topics.)  Or you might prefer to avoid the navigator and go directly to the first search match in the 
 book.  To temporarily change these default search options, choose the Extended button on the Search Book menu.  A Search Book 
 (Extended) dialog box appears containing a How to Show Results area.  From this area, you can select:
  
�   List Topics by Importance (the default)

 �   List Topics in Sequence
 �   Go to Matches in Book Text
  

Note:   How to Show Results is available only in the Search Book (Extended) window.  BookManager Library Reader for Windows always 
        lists multiple-book search results by importance in a Multiple-Book Search Results navigator.
  
  

When you are at a search match within the book, you can move from one search match to another using either the Next Match icon and 
 the Previous Match icon or the Go to Next Match command and the Go to Previous Match command on the Search menu.
  

Note:   Library Reader for Windows maintains only one set of search results at a time.  Results of a subsequent search replace any 
        previously maintained results.
  
  

For information about permanently changing search options, see "Options Menus" in topic 30.0.
  

Related Topics:
  

       In this book:
  

           "Search Request" in topic 43.0
            "Type of Search" in topic 55.0
            "Where to Search" in topic 59.0
            "Search Results Ranking" in topic 45.0
  

       In the User's Guide:
  

           Procedures for using an extended search dialog box
            Procedures for specifying how to show results
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 21.0 Include
  

Use the Include command to include or exclude bookshelves or books from the list displayed in any of the following windows:
  
�   List of Bookshelves window

 �   Bookshelf window
 �   List of Books window
  

From any of these windows, choose the View menu to access the Include command.  You can include bookshelves or books based on 
 name, title, or whether they are selected (highlighted).
  

Related Topics:
  

       In this book:
  

           "Sort" in topic 49.0
            "Refresh" in topic 39.0
  

       In the User's Guide:
  

           Procedures for including and excluding from the List of Bookshelves
            Procedures for including and excluding from the List of Books
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 22.0 List of Books Window
  

The List of Books window lists books that may or may not be grouped in bookshelves.  You create this window from the default startup 
 window--List of Bookshelves--by specifying the path that you want used to create a list of books.
  

In the List of Books window, you can choose from these menus:
  
�   File, from which you can:

  
    -   View a book's description

     -   Create or add to a bookshelf
     -   Reopen a book that is already open (for example, to view a figure while you read its accompanying text)
  
�   Edit, from which you select or deselect books in the list for performing tasks available on the Bookshelf window

  
�   View, from which you activate or deactivate the status bar, as well as:

  
    -   Include or exclude books from the list

     -   Sort the list of books
     -   Refresh the List of Books window
  
�   Search, from which you request a multiple-book search of books on the list

  
�   Window, from which you either close all windows listed as open or access one of them

  
�   Help, from which you access various types of online help for Library Reader for Windows

  
  

For an illustration of a sample List of Books window and detailed explanations of its components, refer to the User's Guide.
  

Related Topics:
  

       In this book:
  

           "Starting BookManager Library Reader for Windows" in topic 50.0
  

       In the User's Guide:
  

           Procedures for listing books
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 23.0 List of Bookshelves Window
  

The default entry window at BookManager Library Reader for Windows startup, the List of Bookshelves window lists bookshelves obtained 
 from the default path specified in your user profile.
  

In the List of Bookshelves window, you can choose from these menus:
  
�   File, from which you can:

  
    -   Open a book or bookshelf

     -   List books or bookshelves
     -   View a description of the bookshelf
     -   Create a bookshelf
     -   Reopen an open book or bookshelf
  
�   View, from which you activate or deactivate the status bar, as well as:

  
    -   Include or exclude bookshelves from the list

     -   Sort the list of bookshelves
     -   Refresh the List of Bookshelves window
  
�   Options, from which you set profile options to make permanent changes to the Library Reader for Windows application

  
�   Window, from which you either close all windows listed as open or access one of them

  
�   Help, from which you access various types of online help for Library Reader for Windows

  
  

For an illustration of a sample Book window and detailed explanations of its components, refer to the User's Guide.
  

Related Topics:
  

       In this book:
  

           "Startup Windows" in topic 52.0
            "Starting BookManager Library Reader for Windows" in topic 50.0
  

       In the User's Guide:
  

           Procedures for using the List of Bookshelves
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 24.0 List Topics by Importance
  

If you select List Topics by Importance (the default) in a search request, BookManager Library Reader for Windows displays the search 
 results as a list of topics in which search matches were found.  Whenever more than one search match is found, topics are arranged in 
 order of probable importance--with matches most likely to be helpful listed first.
  

Library Reader for Windows determines the likely importance of a search match based on the following factors (listed in order of 
 decreasing importance):
  

Location
        Matches are likely to be of greater value if they occur in certain parts of the book.  For example, matches found in the index rank 
        highest, followed by matches in headings, and then in the text.
  

Frequency
        Topics with the most matches rank highest.  When the request contains more than one search word or phrase, frequency also 
        depends on how many words or phrases match.
  

Exactness
        Exact matches, including exact capitalization of letters, rank highest.  Matches that differ only in capitalization rank next, followed by 
        matches that share the same root.
  

Distinctness
        Matches for words or phrases that occur in only a few topics rank higher than matches that occur frequently throughout the book.  
        For example, if you search for the word cats  and the phrase Siamese cats , matches for Siamese cats rank higher than matches for 
        cats. (In this example, the added qualifier Siamese to cats makes the phrase more distinct than the word.)
  

       Also, when two or more topics contain the same number of matches, shorter topics rank higher than longer topics.
  

Sequence similarity
        Search matches on phrases are ranked according to their similarity to the search phrase.  For example, matches on a search for the 
        forest cottage  might rank as:
  

       1.  The forest cottage (identical sequence)
  

       2.  the enchanting forest cottage (identical sequence, with one insertion; contains three search-phrase words)
  

       3.  forest cottage (identical sequence, with one deletion; contains only two search-phrase words)
  

       4.  cottage in this forest (reverse sequence, with one deletion; contains only two search-phrase words)
  
  
  

When you are at a search match within a topic, you can move from one search match to another using either the Next Match icon and the 
 Previous Match icon or the Go to Next Match command and the Go to Previous Match command on the Search menu.
  

Note:   In a multiple-book search, Library Reader for Windows always orders results by importance and displays them in a Multiple-Book 
        Search Results navigator.
  
  

Related Topics:
  

       In this book:
  

           "Search Request" in topic 43.0
            "How to Show Results" in topic 20.0
            "List Topics in Sequence" in topic 25.0
            "Go to Matches in Book Text" in topic 17.0
            "Search Results Ranking" in topic 45.0
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 25.0 List Topics in Sequence
  

If you select List Topics in Sequence in a search request, BookManager Library Reader for Windows displays the search results as a list 
 of topics in which search matches were found.  Topics are listed in the same sequence they occur in the book.
  

When you are at a search match within a topic, you can move from one search match to another using either the Next Match icon and the 
 Previous Match icon or the Go to Next Match command and the Go to Previous Match command on the Search menu.
  

Note:   The List Topics in Sequence option applies only to a book search. (BookManager Library Reader for Windows always lists 
        multiple-book search results by importance in a Multiple-Book Search Results navigator.)  To change the option temporarily, select 
        List Topics in Sequence (located in the How to Show Results area of the Search Book (Extended) window).  For information about 
        permanently changing search options, see "Options Menus" in topic 30.0.
  
  

Related Topics:
  

       In this book:
  

           "Search Request" in topic 43.0
            "How to Show Results" in topic 20.0
            "List Topics by Importance" in topic 24.0
            "Go to Matches in Book Text" in topic 17.0
            "Extended Searches" in topic 13.0
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 26.0 Messages
  

BookManager Library Reader for Windows displays messages in a message box that contains an icon, explanatory text, and buttons.  
 Library Reader for Windows writes critical messages to an error-log file as well as displays them in a message box.  Different message 
 types appear in response to different actions:
  
  
�   An information message, identified by a lowercase i, indicates that a computer function either is performing normally or has performed 

     normally.
  
�   A warning message, identified by an exclamation point (!), indicates that a potentially undesirable situation could occur.  You must 

     respond to a warning message to continue.
  
�   An error message, identified by a Stop Sign icon, indicates that a situation exists which must be corrected by some action. (12)

  
  (12) When help is available for an error message, "F1" is
     displayed in the message box.  To see the help text, press
     F1.
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 27.0 Navigate Menu
  

Available only on the Book window, the Library Reader for Windows Navigate menu offers two types of commands:
  
�   The first group of commands (those that begin with "By") access navigator windows that list areas of the book.

  
�   The second group of commands (those that begin with "Go to") take you to a specific place in the book.

  
  
  
 Table 6. Navi gate Menu
 from Book
  
 Navi gate
     By Topics...         Ctrl+T
     By Topics Seen...    Ctrl+H
     By Revisions...      Ctrl+Shift+R
     By Figures...        Ctrl+F
     By Ta bles...         Ctrl+B
     By I ndex...          Ctrl+I
     --------------------------------
     Go to Topic ID...    Ctrl+G
     Go to Book mark
     Go to Previous Link  Ctrl+L
     Go to Pre v ious Topic Ctrl+PgUp
     Go to Ne x t Topic     Ctrl+PgDn
  
  

One key feature of a navigator window is that you can find where you want to go without moving the book text--you can view a navigator 
 and book text concurrently.  Only when you link from the navigator does the book text change.  Also, you can view more than one navigator 
 at a time.  Some navigators let you select more than one topic at a time for printing.
  
  
�   When you choose By Topics, the Topics navigator appears.  It lists topics in a book and serves as the table of contents. (13) 

     Choosing a topic from the list links you to that topic.
  
�   When you choose By Topics Seen, the Topics-Seen navigator appears.  It lists topics you have already seen in the current session.  

     Choosing a topic from the list links you to that topic.
  

�   When you choose By Revisions, the Revisions navigator appears.  It lists revised topics.  Choosing a topic from the list links you to 
     that topic.
  
�   When you choose By Figures, the Figures navigator appears.  It lists the figures in the book.  Choosing a figure from the list links you to 

     that figure.
  
�   When you choose By Tables, the Tables navigator appears.  It lists the tables in the book.  Choosing a table from the list links you to 

     that table.
  
�   When you choose By Index, the Index navigator appears.  It lists index entries for the book you are viewing.  It resembles a hardcopy 

     index, but has all the advantages of the functions available in softcopy. Choosing an item from the index links you to that topic.  Use the 
     Index navigator to find specific information that relates to a subject.
  
  

The remaining commands on the Navigate menu are those that take you to specific places in the book:
  
�   When you choose Go to Topic ID, a dialog box appears.  You type the topic identifier in the box and choose OK to go directly to the 

     topic you want.  (If the identifier does not exist, a message appears indicating the identifier was not found.)
  
�   When you choose Go to Bookmark, Library Reader for Windows takes you directly to the bookmark.  (This command is not available if 

     no bookmark exists.)
  
�   When you choose Go to Previous Link, Library Reader for Windows takes you to the link used most recently.

  
�   When you choose Go to Previous Topic, Library Reader for Windows takes you to the beginning of the topic that precedes the topic 

     you are currently viewing.
  
�   When you choose Go to Next Topic, Library Reader for Windows takes you to the beginning of the topic that follows the topic you are 

     currently viewing.
  
  
  

Related Topics:
  

       In the User's Guide:
  

           Procedures for using the Topics navigator
            Procedures for returning to topics already viewed
            Procedures for finding topics with revisions
            Procedures for finding figures
            Procedures for finding tables
            Procedures for using the Index navigator
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            Procedures for going to a specific topic identifier
            Procedures for finding the bookmark
            Procedures for returning from a link
            Procedures for returning from a link
  
  (13) The author of the book determines whether to create a table
     of contents and, if so, the heading levels to i nclude.  For
     example, even though a book might contain as ma ny as seven
     heading levels, the author can specify that onl y heading
     levels 1 through 3 be included in the table of contents.  In
     this example, the Topics navigator lists the au thor-defined
     table of contents.  Otherwise, if the author do es not create
     a table of contents, the Topics lists all topic s in the book.
     In either case, you can move from topic to topi c by using
     either the Next Topic icon and the Previous Top ic icon or the
     Go to Pre v ious Topic command and the Go to Ne x t Topic
     command.
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 28.0 Notes
  

Just as you might write in the margins of a printed book, you can create, view, and revise notes in softcopy books.  You can also display a 
 list of your notes and delete any you do not want to keep.
  

BookManager Library Reader for Windows saves notes in a file separate from the file that contains the book.  The default notes file name 
 is the same as the book file name; the default notes file extension is .NTF.  For example, a file called PROJECT4.NTF contains the notes 
 for a book called PROJECT4.BOO.
  

Note:    Because Library Reader for Windows cannot prevent several users on a local area network (LAN) from having concurrent write 
        access, share mode is implemented at installation.  When a notes file is marked read/write, only one user at a time can view and 
        modify notes.  Similarly, when a notes file is marked read-only, users can access it only as read-only.
  
  

You can display a list of notes for a book by choosing the Display Notes List command from the Notes menu in the Book window.  A Notes 
 List navigator appears listing topic identifiers, and the first line of the Choosing an identifier from the list links you to that topic.  From this 
 navigator you can:
  
�   Open notes for viewing

 �   Delete notes
 �   Print topics that contain notes, including the note's text
  
  

Related Topics:
  

       In this book:
  

           "Notes Menus" in topic 29.0
            "Share Mode (DOS)" in topic 46.0
  

       In the User's Guide:
  

           Procedures for making notes in a book
            Procedures for using the Notes List navigator
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 29.0 Notes Menus
  

Table 7 compares the various Library Reader for Windows Notes menus. Notice that commands available on a Notes menu vary, 
 depending on where you are in the application.  For all menu commands, Library Reader for Windows offers:
  
�   Context-sensitive help, which describes the purpose and use of the command

  
�   Short help, which displays (in the status bar) a one-line description of the command

  
  
  
 Table 7. Comparison of Notes Menus
 from Book                                    from Notes List
  
 Notes                                       Notes
     New...               Ctrl+N                 Op en...
     Display Notes List...   Ctrl+Shift+N        Delete
     Use Other Notes...
  
  
  

Related Topics:
  

       In this book:
  

           "Notes" in topic 28.0
  

       In the User's Guide:
  

           Procedures for making notes in a book
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 30.0 Options Menus
  

You use Library Reader for Windows Options menus to permanently change default settings stored in your user profile.  You can find an 
 Options menu on any of the following:
  
�   Book window

 �   Bookshelf window
 �   List of Bookshelves window
  
 Your user profile contains default settings for:
  
�   Search options for both book searches and multiple-book searches

 �   Color options for displaying book text
 �   Font options for displaying book text
 �   Workspace options for activating and deactivating the tool bar, the status bar, and--when opening a book--the Topics window
 �   Path options for notes files and for startup
 �   Confirmation options for exiting Library Reader for Windows
  

The commands available on Options menus let you make permanent changes to these defaults.
  

Note:   Changes made in menus other than Options (as well as in dialog boxes) act as temporary changes and remain active only as long 
        as the book is open.
  
  
 Table 8. Comparison of Options Menus
 from List of Bookshelves                     from Bookshelf
  
 Options                                     Options
     Searches                                    Searches  
         Book...                                     Book...
         Book shelf...                                Book shelf...
     Wor kspace...                                Wor kspace...
     Startup Defaults...                         Startup Defaults...
     Confirmations...                            Confirmations...
     -------------------                         --- ----------------
     Sa ve Window                                 Sa ve Window
  
 from Book
  
 Options
     Searches  
         Book...
         Book shelf...
     C olors...
     Fonts  
         For Reflowable Text...
         For Nonreflowable Text...
     Wor kspace...
     Startup Defaults...
     Confirmations...
     ------------------------------
     Sa ve Window
  
  
  

Related Topics:
  

       In this book:
  

           "User Profile" in topic 57.0
  

       In the User's Guide:
  

           Procedures for changing options
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 31.0 Picture Window
  

When pictures are not integrated into the text of a softcopy book, you view pictures by choosing a picture link.  BookManager Library 
 Reader for Windows displays such pictures in a Picture window, which offers the following menus:
  
�   Edit, from which you can copy the picture to the Clipboard.

  
�   View, from which you can enlarge or reduce the size of the picture

  
�   Print, from which you can print the picture using current printer defaults and options

  
�   Help, from which you can access various types of online help for Library Reader for Windows

  
  

The default size of the Picture window varies according to the size of the picture.  Library Reader for Windows attempts to display the 
 entire picture and maintain its original resolution.  However, if the size of the picture exceeds the size of the window, scroll bars appear on 
 the Picture window.  Using scroll bars, you move the picture (up, down, left, or right) to view it in its entirety.
  

For an illustration of a sample Picture window and detailed explanations of its components, refer to the User's Guide.
  

Related Topics:
  

       In the User's Guide:
  

           Procedures for viewing pictures
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 32.0 Pictures in Softcopy
  

Softcopy information can contain two types of pictures:
  
�   Vector graphics, which contain "drawing orders" that permit scaling without resolution loss

  
�   Raster images, which have a fixed resolution and can diminish in quality when scaled

  
  

Pictures can appear in softcopy either integrated with the text or as a hypertext link (the word "PICTURE" followed by its identifier).  Both 
 types of pictures can be displayed in a Picture window, from which you can copy, zoom, or print the picture while simultaneously viewing 
 the text. You specify how you want to view pictures through workspace options in an Options menu.
  

Note:   Integrated pictures display best in books built with BookManager BUILD 1.3.  Pictures can be integrated in books built with earlier 
        versions, but with varying and possibly less-than-optimal results. Also, in books built with earlier versions, pictures specified as 
        RUNIN art (in the source file) cannot be integrated and must be viewed in a Picture window.
  
  

Related Topics:
  

       In this book:
  

           "Picture Window" in topic 31.0
  

       In the User's Guide:
  

           Procedures for viewing pictures
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 33.0 Print Menus
  

Table 9 compares the various Library Reader for Windows Print menus. Notice that commands available on a Print menu vary slightly, 
 depending on where you are in the application.  For all menu commands, Library Reader for Windows offers:
  
�   Context-sensitive help, which describes the purpose and use of the command

  
�   Short help, which displays (in the status bar) a one-line description of the command

  
  
  
 Table 9. Comparison of Print Menus
 from Picture                                 from Topics
  
 Print                                       Print
     Print Picture... Ctrl+Shift+P               Print...
     Print Pre v iew...                            Print Selected Topics...
     P r int Setup...                              Print Pre v iew...
                                                 P r int Setup...
  
 from Search Results                          from Topics-Seen
  
 Print                                       Print
     Print...                                    Print...
     Print Selected Topics...                    Print Selected Topics...
     Print Pre v iew...                            Print Pre v iew...
     P r int Setup...                              P r int Setup...
  
 from Notes List                              from Revisions
  
 Print                                       Print
     Print Selected Topics...                    Print...
     Print Pre v iew...                            Print Selected Topics...
     P r int Setup...                              Print Pre v iew...
                                                 P r int Setup...
  
  

Note:   From any of the navigators shown in Table 9, you can select and print topics.  By selecting the topics you want printed and then 
        choosing the Print Selected Topics command, you can:
  

       �   Preview formatted topics without printing them
        �   Check or change printer options before printing topics
  
  
  

Related Topics:
  

       In this book:
  

           "Print Preview" in topic 34.0
            "Print Setup" in topic 35.0
  

       In the User's Guide:
  

           Procedures for printing selected topics from navigators
            Procedures for printing an entire book
            Procedures for printing marked text
            Procedures for printing one topic
            Procedures for printing pictures
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 34.0 Print Preview
  

When you choose Print Preview from a Book window's File menu, BookManager Library Reader for Windows displays a preview of 
 formatted topics as they would appear on the selected printer.  Viewing this preview gives you the option of changing the printer selection 
 without printing the output.
  

Related Topics:
  

       In this book:
  

           "Print Setup" in topic 35.0
            "Printing Softcopy Information" in topic 36.0
  

       In the User's Guide:
  

           Procedures for previewing printed output
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 35.0 Print Setup
  

When you choose Print Setup from a Book window's File menu, BookManager Library Reader for Windows displays a printer-selection 
 dialog box.  Use this dialog box to check or change printer options and change the printer selection before printing softcopy.
  

Related Topics:
  

       In this book:
  

           "Print Preview" in topic 34.0
            "Printing Softcopy Information" in topic 36.0
  

       In the User's Guide:
  

           Procedures for setting up for printing
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 36.0 Printing Softcopy Information
  

BookManager Library Reader for Windows allows you to send information from a book to a printer connected to your computer or 
 available to you on a local area network (LAN).  For example, you can:
  
�   Print an entire softcopy book

 �   Print one or more selected topics
 �   Print topic text marked for printing
 �   Print only topics containing search results
 �   Print only topics containing notes  (with or without the notes text)
 �   Print only notes
 �   Print only topics containing revisions
 �   Print only topics that you have already seen
 �   Print pictures
  

    Note:   Before printing pictures, consider:
  

           -   You must have a graphics printer to print pictures.
  

           -   If the topic text contains an integrated picture, the picture prints; if the text contains a picture link (for example, PICTURE 1), the 
                link text prints instead.
  

           -   Pictures are bitmaps; their printed quality depends on the dots-per-inch (DPI) resolution of your printer.  A picture that prints 
                cropped at the right and bottom margins on a dot matrix printer might print in its entirety on a laser printer.
  
  
  
  

Related Topics:
  

       In this book:
  

           "Softcopy" in topic 48.0
            "Reading Softcopy Information" in topic 37.0
            "Print Preview" in topic 34.0
            "Print Setup" in topic 35.0
  

       In the User's Guide:
  

           Procedures for printing an entire book
            Procedures for printing one topic
            Procedures for printing selected topics from navigators
            Procedures for printing marked text
            Procedures for printing notes
            Procedures for printing pictures
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 37.0 Reading Softcopy Information
  

Reading a softcopy book with Library Reader for Windows means looking at the book's text and illustrations (14) (if any) in windows on 
 your display screen.  With Library Reader for Windows (or any other BookManager Library Reader product), you can read softcopy books 
 created by BookManager BUILD. (15)
  

If you prefer to read the book sequentially, Library Reader for Windows makes it easy for you to go through the book paragraph by 
 paragraph and topic by topic.  But Library Reader for Windows also gives you the freedom to move through the book in random fashion, 
 going directly to the topic, illustration, or even word that most interests you.
  

Methods for moving through a softcopy book include:
  

Scrolling
        Scrolling is the softcopy equivalent of going through a hardcopy book page by page.  By scrolling through each topic--one at a 
        time--you are assured of seeing all the information within the book.  This is the method to use if you want to read the book sequentially 
        from cover to cover.
  

Using navigators
  

       In this book: Navigator windows (for example, Topics) let you pick from a list of topic titles or other information and go directly to the 
        ones that interest you.  Using the navigator windows also lets you focus on reading only certain types of information--for example, 
        topics that you have already seen but want to reread, or notes.
  

Linking
  

       In this book: Linking offers you a quick way to get to related information.  If, while reading a topic, you encounter a term or concept that 
        is unfamiliar, you can link from that spot to a definition or explanation, then return to your place to continue reading.
  

Searching
  

       In this book: You can search one or more books for a specific word or phrase.  When the list of search matches is displayed, you can 
        go directly to the topics containing that word or phrase.
  
  
  

Related Topics:
  

       In this book:
  

           "Softcopy" in topic 48.0
            "Printing Softcopy Information" in topic 36.0
  

       In the User's Guide:
  

           Procedures for using links
  
  (14) In this context, illustrations  refers to such  document
     elements  as  figures ,  tables , and  pictures .
  
  (15) Library Reader for Windows cannot read books built using a
     BookManager BUILD 1.0 or 1.1 product.
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 38.0 Reflow
Reflow refers to adjusting the width of lines of text (similar to "word wrap" in word processors) to fit within the margins provided; paragraph 

 text and list-item text are usually reflowable.  When text is reflowable, line widths adjust to fit within margins by splitting lines between 
 words--words are not split or hyphenated.  When text is nonreflowable, its line widths remain the same, regardless of the margins 
 provided; figure text and table text are examples of nonreflowable text.
  

When BookManager BUILD 1.3 builds a softcopy book from a source file, it marks certain document elements as reflowable and others 
 as nonreflowable. When you view that softcopy book using Library Reader for Windows, reflowable text displayed in the Book window 
 reflows when you change fonts or font sizes and when you resize the window.  When viewing nonreflowable text that exceeds the right 
 margin of the window, you must scroll from left to right to view it in its entirety.
  

Note:   You can choose either a proportional font or a monospaced font for displaying reflowable text.  However, you can choose only a 
        monospaced font for displaying nonreflowable text.  Existing books built without reflow support (using BUILD 1.2) display as 
        nonreflowable--they display in a monospaced font.  To find out the version of BUILD used to build the book you are viewing, choose 
        the Book Description command in the File menu.
  

       If you want to change the default fonts for either reflowable text or nonreflowable text, use the Options menu to permanently update 
        your user profile.
  
  

Related Topics:
  

       In this book:
  

           "Fonts" in topic 16.0
            "Revisions" in topic 41.0
            "User Profile" in topic 57.0
  

       In the User's Guide:
  

           Procedures for changing fonts
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 39.0 Refresh
  

Use the Refresh command to recreate and redisplay a list of bookshelves or books (after additions or deletions) in any of the following 
 windows:
  
�   List of Bookshelves window

 �   Bookshelf window
 �   List of Books window
  

From any of these windows, choose the View menu to access the Refresh command.  A refreshed list reflects changes made since the 
 window was opened or since the last refresh, including:
  
�   A new bookshelf created using Library Reader for Windows

 �   A bookshelf copied (using DOS commands) to your startup path
 �   A bookshelf deleted (using DOS commands)
 �   A book added to a bookshelf using the Add Selected Books to Another Bookshelf command
 �   A new book file copied (using DOS commands) into a directory in the startup path
 �   A book file deleted (using DOS commands)
  

A refresh also undoes the effects of any Include or Sort commands.
  

Related Topics:
  

       In this book:
  

           "Include" in topic 21.0
            "Sort" in topic 49.0
  

       In the User's Guide:
  

           Procedures for refreshing the List of Bookshelves
            Procedures for refreshing the Bookshelf
            Procedures for refreshing the List of Books
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 40.0 Retrieve Previous Searches
  

BookManager Library Reader for Windows saves prior search requests during a Book window session.  From any Search dialog box, 
 choose Retrieve Previous Searches to display prior search requests and simultaneously retrieve their associated search options.  
 Selecting a prior request selects its search options and displays its text in the Search Request box.
  
�   To use the same search options, simply type over the text to enter a different request.

  
�   To alter the retrieved search options, choose the Extended button and make alterations in the extended search dialog box.  (Library 

     Reader for Windows stores the new search request and its new options in the list of search requests for the next retrieval.)
  
  
  

Related Topics:
  

       In this book:
  

           "Search Menus" in topic 42.0
            "Extended Searches" in topic 13.0
  

       In the User's Guide:
  

           Procedures for using a prior search request
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 41.0 Revisions
  

A Revisions navigator lists topics that contain revisions. (16) When you link to a topic, you identify revised text by looking for a revision 
 character in the left margin.  The author of the book determines which revision character to use.  Occasionally, a book contains more than 
 one revision character (for example, to distinguish revisions in a second draft from revisions in a third draft).  Library Reader for Windows 
 displays only one revision character for each revised line; if more than one revision character applies to the same line, Library Reader for 
 Windows displays the last revision character in the sequence.  For this reason, if the revised text is reflowed, a revision character might 
 disappear if you resize the window.
  

For an illustration of a sample Revisions window and detailed explanations of its components, refer to the User's Guide.
  

Related Topics:
  

       In this book:
  

           "Reflow" in topic 38.0
  

       In the User's Guide:
  

           Procedures for finding topics with revisions
  
  (16) A Revisions navigator is available only  when a book
     contains topics with revisions.
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 42.0 Search Menus
  

With softcopy, you can search for words and phrases in:
  
�   A single book, from the Book window

  
�   Multiple books, from either the Bookshelf window or the List of Books window

  
  

Table 10 compares the various Library Reader for Windows Search menus. Notice that commands available on a Search menu vary, 
 depending on where you are in the application.  For all menu commands, Library Reader for Windows offers:
  
�   Context-sensitive help, which describes the purpose and use of the command

  
�   Short help, which displays (in the status bar) a one-line description of the command

  
  
  
 Table 10. Comparison of Search Menus
 from List of Books                           from Bookshelf
  
 Search                                      Search
     All Books Listed...    Ctrl+S               All Books Listed...       Ctrl+S
     Selected Books Only... Ctrl+Shift+S         Selected Books Only...    Ctrl+Shift+S
     -------------------------------------       --- ----------------------------
     Display Search Results... Ctrl+R            Display Search Results... Ctrl+R
  
 from Book
  
 Search
     Search Book...          Ctrl+S
     Display Search Results...  Ctrl+R
     -----------------------------
     Go to Previous Match    Ctrl+Shift+M
     Go to Next Match        Ctrl+M
     Go to Previous Topic Match
     Go to Ne x t Topic Match
     -----------------------------
     Emphasize Matches
  
  
  

Related Topics:
  

       In this book:
  

           "Extended Searches" in topic 13.0
  

       In the User's Guide:
  

           Procedures for searching for information
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 43.0 Search Request
  

When you search for information, you first set up a search request.  In your search request, you explain to Library Reader for Windows 
 the information you want to find.  For example, you can search for a word or a phrase.  Similar to a mathematical expression, a search 
 request can also contain operators, which you can use to search for combinations of words and phrases.  For example:
  
�   Wildcard characters (asterisks and question marks) for substituting characters in your request

  
�   Word or phrase separators (commas) for indicating where words or phrases begin and end

  
�   Boolean operators for broadening or narrowing the results of your search

  
�   Grouping operators (parentheses) for enclosing words and phrases to assign precedence to them in Boolean searches

  
�   "As is" operators (single quotes) for enclosing operator characters when you want them honored in a search request.  Table 11 

     shows the operator characters.
  
 +-------------------------------------------------- ----------------------+
 ¦ Table 11. Characters Assigned to Search-Request O perators              ¦
 +-------------------------------------------------- ----------------------¦
 ¦   ?   ¦ question mark, a single-character wildcard                     ¦
 +-------+------------------------------------------ ----------------------¦
 ¦   *    ¦ asterisk, a multiple-character wildcard                        ¦
 +-------+------------------------------------------ ----------------------¦
 ¦   ,    ¦ comma, a word or phrase separator                              ¦
 +-------+------------------------------------------ ----------------------¦
 ¦   &   ¦ ampersand, a Boolean operator representing &                   ¦
 +-------+------------------------------------------ ----------------------¦
 ¦   |    ¦ vertical bar, a Boolean operator representing |                 ¦
 +-------+------------------------------------------ ----------------------¦
 ¦   !    ¦ exclamation point, a Boolean operator represen ting !            ¦
 +-------+------------------------------------------ ----------------------¦
 ¦  ( )   ¦ parentheses, grouping operators                                ¦
 +-------+------------------------------------------ ----------------------¦
 ¦  ' '   ¦ single quotes, "as is" operators                               ¦
 +-------------------------------------------------- ----------------------+
  
  

Note:   Extended search dialog boxes provide buttons that, when chosen, insert operators into the Search Request text box.  You 
        complete the search request by typing the words or phrases into the text box.  For more information about the buttons and how they 
        relate to the insertion point, refer to the User's Guide.
  
  

By default, Library Reader for Windows lists topics containing search matches in a Search Results navigator.  Also by default, the topics 
 are listed by importance.  Choosing a topic from the list links you to that topic.  Although these are your only options in a multiple-book 
 search, you can change the options in a book search.  For example, you can request that topics be listed in sequence.  Or you can 
 request to bypass the Search Results navigator and go directly to search matches in the book. To change the options temporarily, make 
 the selections you want in the How to Show Results area of the Search Book (Extended) window.  For information about permanently 
 changing search options, see "Options Menus" in topic 30.0.
  

Related Topics:
  

       In this book:
  

           "Wildcard Characters" in topic 60.0
            "Word or Phrase Separator" in topic 63.0
            "Boolean Operators" in topic 10.0
            "Grouping Operators" in topic 18.0
            ""As Is" Operators" in topic 1.0
            "Word Check" in topic 62.0
            "Retrieve Previous Searches" in topic 40.0
            "Type of Search" in topic 55.0
            "List Topics by Importance" in topic 24.0
            "List Topics in Sequence" in topic 25.0
            "Go to Matches in Book Text" in topic 17.0
            "Extended Searches" in topic 13.0
            "Search Results Ranking" in topic 45.0
  

       In the User's Guide:
  

           Procedures for typing a search request
            Procedures for using the Search Results navigator
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 44.0 Search Request Examples
This topic lists the various search request examples provided in this book.  If you are interested in seeing examples, use links in the list to 

 view the examples that interest you.
  
�   Examples of search requests with fuzzy matches

  
�   Example of a search request that uses a multiple-character wildcard

  
�   Example of a search request that uses a single-character wildcard

  
�   Examples of search requests that use word or phrase separators

  
�   Examples of search requests that use Boolean operators

  
�   Examples of search requests that use "as is" operators

  
�   Example of a search request that uses grouping operators

  
�   Examples of search requests that demonstrate ranking based on sequence similarity
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 45.0 Search Results Ranking
  

To understand search results ranking, you must first be aware of the many defaults used.  Figure 1 shows the defaults that Library 
 Reader for Windows uses when you issue a search request.
  
  
 �   What to Search For
  
     -   Search Request--the operators' default orde r of precedence:
  
         1.  Single-character wildcard
  
 

  
  
             Multiple-character wildcard
  
 

  
  
             Word or phrase separator
  
 

  
  
         2.  "As is" operator
  
 

  
  
         3.  Grouping operator
  
 

  
  
         4.  Boolean "but not" operator
  
 

  
  
         5.  Boolean "and" operator
  
 

  
  
         6.  Boolean "or" operator
  
 

  
  
  
     -   Type of Search--default is Fuzzy Match
  
  
 �   Where to Search--default is all  available selections:
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     -   Topic Titles
     -   Topic Text
     -   Indexed Words
  
 �   How to Show Results--default is List Topics by I mportance:
  
     1.  Location
         a.  Index
         b.  Topic titles
         c.  Topic text
     2.  Frequency
     3.  Exactness
     4.  Distinctness
     5.  Sequence Similarity
  
  
  
 Figure 1. Defaults Used for Ranking Search Results
  

Your ability to change search-ranking defaults depends on whether you search a single book or multiple books.  (You have more flexibility 
 when searching a single book.)  You change search-ranking defaults by changing search options:
  
�   To temporarily change search options, choose Extended in either the Search Book window or the Search Multiple Books window.

  
�   To permanently change search options, update your user profile by choosing Searches from the Options menu.  A Searches 

     cascading menu appears, from which you:
  

    -   Choose Book to permanently change book search options.
     -   Choose Bookshelf to permanently change multiple-book search options.
  
  

In a multiple-book search, the only search-ranking default you can change is the operators' order of precedence.  (As described in 
 "Grouping Operators" in topic 18.0, adding grouping operators to a Boolean expression overrides the Boolean operators' default order of 
 precedence.) Unlike searching a book:
  
�   Fuzzy Match is the only Type of Search used in multiple-book searches; you cannot request Exact Match.

  
�   Library Reader for Windows always searches Topic Titles, Topic Text, and Indexed Words in multiple-book searches; you cannot 

     focus your search by selecting some combination.
  

    Note:   You can locate words or phrases in book titles by selecting Include by Title from the View menu.  For more information, refer to 
            procedures for changing or sorting the List of Books in the User's Guide.
  
�   Library Reader for Windows always shows multiple-book search results by importance; you cannot request that they be listed in 

     sequence. Nor can you request to be taken directly to search matches; Library Reader for Windows always displays multiple-book 
     search results in a navigator.
  
  

You have a lot more control over search results ranking when you search a single book.  For example:
  
�   As already mentioned, adding grouping operators to a Boolean search request overrides the Boolean operators' default order of 

     precedence.
  
�   Choosing Exact Match (instead of Fuzzy Match) eliminates the need for some ranking:

  
    -   Exactness (defined in "List Topics by Importance" in topic 24.0) no longer applies if you want capitalization honored.

     -   Sequence similarity (also defined in "List Topics by Importance" in topic 24.0) no longer applies.
  
�   Requesting that results be listed in sequence (instead of by importance) eliminates the need for all ranking; location, frequency, 

     exactness, distinctness, and sequence similarity (all defined in "List Topics by Importance" in topic 24.0) no longer apply.  For this 
     reason, selecting List Topics in Sequence can improve the speed with which Library Reader for Windows processes your search 
     request.
  
  

Note:   The algorithm used by Library Reader for Windows to rank search results contains an enhancement over the algorithm used by 
        previous READ products and, therefore, may yield slightly different--but more accurate--results.
  
  

Related Topics:
  

       In this book:
  

           "Wildcard Characters" in topic 60.0
            "Word or Phrase Separator" in topic 63.0
            ""As Is" Operators" in topic 1.0
            "Grouping Operators" in topic 18.0
            "Boolean Operators" in topic 10.0
            "Type of Search" in topic 55.0
            "Where to Search" in topic 59.0
            "How to Show Results" in topic 20.0
            "User Profile" in topic 57.0
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       In the User's Guide:

  
           Procedures for using an extended search dialog box

            Procedures for changing search options
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 46.0 Share Mode (DOS)
  

Sharing refers to the concept of making resources available to other workstations.  On a local area network (LAN), for example, 
 workstations share many types of resources, including directories and printers.
  

As described in "Notes" in topic 28.0, BookManager Library Reader for Windows saves notes created in a softcopy book in a file separate 
 from the book file.  A notes file is another resource shared among users.  If all users have read-only access to the notes file, multiple 
 users can open it concurrently.  If one or more users has write access to the notes file, the first user with write access to open the notes 
 file locks out all other users.  The first user has to close the notes file and the book before a second user can open the notes file.  If the 
 second user has the book open concurrent with the first user, the second user has to close and reopen the book before opening the 
 notes file.  Library Reader for Windows implements this exclusive write access through share mode (set up at installation).
  

Note:   To revise or delete notes from the notes file, the notes file must be marked read/write.
  
  

Related Topics:
  

       In this book:
  

           "Notes" in topic 28.0
  

       In the User's Guide:
  

           Procedures for viewing notes
            Procedures for creating notes
            Procedures for changing notes
            Procedures for deleting notes
            Procedures for using other notes
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 47.0 Shortcut Keys
  

Some commands on BookManager Library Reader for Windows menus have single keys or key combinations associated with them that 
 allow you to process the command without accessing the menu and choosing the command.  These keys and key combinations are 
 called shortcut keys.  (They are listed to the right of their commands on the menus.)
  

To use a single shortcut key, press the key.  To use a shortcut key combination, hold down the first key of the combination and press the 
 second key.
  

Note:   Shortcut key combinations are shown with a plus sign between them. For example, to create a note while viewing a softcopy book, 
        press Ctrl+N.  In other words, hold down the Ctrl key and press N.
  

To view a list of all Library Reader for Windows shortcut keys, either choose Keys Help from any Help menu or refer to the shortcut key 
 tables in the Quick Reference.
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 48.0 Softcopy
  

Softcopy is information that you can read on the display screen of your workstation.  Softcopy is not the same as the information in a 
 product's windows or online helps.  That kind of information requires that you run the product to get to the information, but softcopy can be 
 read, searched, and printed independently, using an application designed specifically for softcopy reading--such as BookManager Library 
 Reader for Windows.
  

Softcopy can be very simple information, containing only paragraphs and perhaps some headings--like the reports and memos that 
 abound in the business world.  Or softcopy can resemble a printed book, containing all the parts that most books have.  For example, 
 softcopy can contain a cover page, a table of contents, lists of figures and tables, chapters of text, artwork, a glossary, and an index.
  

You can use softcopy in a variety of ways.  For example, you can read softcopy from beginning to end, the same way that you might read a 
 traditional textbook or novel.  Or you can go directly to the exact section of softcopy text that you need.  Softcopy can also serve as a 
 springboard into types of information that are not normally associated with printed books.  For example, from Library Reader for Windows 
 you can link to multimedia applications that you can view or listen to while reading the book's text.
  

Related Topics:
  

       In this book:
  

           "BookManager" in topic 4.0
            "Reading Softcopy Information" in topic 37.0
            "Printing Softcopy Information" in topic 36.0
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 49.0 Sort
  

Use the Sort command to resequence bookshelves or books listed in any of the following windows:
  
�   List of Bookshelves window

 �   Bookshelf window
 �   List of Books window
  

From any of these windows, choose the View menu to access the Sort command.  You can sort bookshelves or books based on name 
 (the default), date, or title.  If you are sorting books (listed in either Bookshelf or List of Books), you can also sort by document number.
  

Related Topics:
  

       In this book:
  

           "Include" in topic 21.0
            "Refresh" in topic 39.0
  

       In the User's Guide:
  

           Procedures for sorting the List of Bookshelves
            Procedures for sorting the List of Books
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 50.0 Starting BookManager Library Reader for Window s
  

There are several ways to start Library Reader for Windows:
  
�   Choosing the Library Reader for Windows icon from Microsoft Windows Program Manager

 �   Opening directly to a Library Reader for Windows bookshelf or book from Microsoft Windows File Manager
 �   Using the Windows Run command from either Program Manager or File Manager
  

Note:   Hypertext links from one book to another in the same bookshelf work only when the book is opened from that bookshelf.
  
  

To start Library Reader for Windows from Program Manager:
        Choose the Library Reader for Windows icon in the BookManager group.  The Library Reader for Windows Welcome window 
        appears briefly, and then the List of Bookshelves window appears.  The bookshelves listed are those that Library Reader for 
        Windows found in the Library Reader for Windows startup path If the List of Bookshelves is empty (meaning that none could be found 
        in the startup path), or if the bookshelves listed are not the ones you want, you can request a different list.
  

To start Library Reader for Windows from File Manager:
        Choose the icon for the Library Reader for Windows bookshelf or book you want to use.  If you choose a bookshelf, the Bookshelf 
        window appears.  If you choose a book, the Book window appears.
  

To start Library Reader for Windows from either Program Manager or File  using the Windows Run command:
        Include a startup command that specifies the startup option you want.
  

       Note:   Using the Run command is also one way you can start Library Reader for Windows running in several windows 
               simultaneously, each using a different startup option.
  
  

       Figure 2 lists each startup command and describes the option associated with it.
  
  
 +-------------------------------------------------- ----------------------+
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦ READIBM                                                                ¦
 ¦                                                                        ¦
 ¦    Opens a List of Bookshelves containing bookshe lves found in the     ¦
 ¦    default startup path.                                               ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦ READIBM shelfname-with-wildcards                                        ¦
 ¦                                                                        ¦
 ¦    Opens a List of Bookshelves containing bookshe lves found in the     ¦
 ¦    default startup path whose names match the pat tern established by   ¦
 ¦    the wildcards.                                                      ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦    Note:   When you use this startup option to limit the con tents of a  ¦
 ¦           List of Bookshelves, the View/ Refresh menu command does not  ¦
 ¦           restore any excluded bookshelves to the  list.  However, if   ¦
 ¦           instead you use wildcards from View/ I nclude/By Name, then    ¦
 ¦           using the View/ Refresh menu command does restore the full    ¦
 ¦           list.                                                        ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦ READIBM bookname                                                        ¦
 ¦                                                                        ¦
 ¦    Opens the named book if found in the default s tartup path.          ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦    Note:   If a bookshelf exists with the same name as the b ook,        ¦
 ¦           Library Reader for Windows opens the bo okshelf instead of    ¦
 ¦           the book.                                                    ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦ READIBM shelfname                                                       ¦
 ¦                                                                        ¦
 ¦    Opens the named bookshelf if found in the defa ult startup path.     ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦    Note:   If the named bookshelf can't be found and a book with the    ¦
 ¦           same name exists, Library Reader for Wi ndows opens the book  ¦
 ¦           instead.                                                     ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦ READIBM bookname  /b                                                     ¦
 ¦                                                                        ¦

BookManager Library Reader for Windows: Online Refe rence
Starting BookManager Library Reader for Windows

¦ Copyright IBM Corp. 1989, 1994
50.0 - 1



 ¦    Opens the named book when both a bookshelf and  a book in the        ¦
 ¦    default startup path share the same name.                           ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦ READIBM shelfname  /s                                                    ¦
 ¦                                                                        ¦
 ¦    Opens the named bookshelf when both a bookshel f and a book in the   ¦
 ¦    default startup path share the same name.                           ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦ READIBM bookname .BOO                                                   ¦
 ¦                                                                        ¦
 ¦    Opens the named book if found in the default s tartup path.          ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦ READIBM shelfname .BKS                                                   ¦
 ¦                                                                        ¦
 ¦    Opens the named bookshelf if found in the defa ult startup path.     ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦ READIBM \ path\bookname .BOO                                             ¦
 ¦                                                                        ¦
 ¦    Opens the named book if found in the specified  path and temporarily ¦
 ¦    appends that path to the front of the startup path.                 ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦ READIBM \ path\shelfname .BKS                                             ¦
 ¦                                                                        ¦
 ¦    Opens the named bookshelf if found in the spec ified path and        ¦
 ¦    temporarily appends that path to the front of the startup path.     ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦ READIBM bookname  /f  search request                                      ¦
 ¦                                                                        ¦
 ¦    Opens the named book and searches for the word s or phrases          ¦
 ¦    specified in the search request.                                    ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦    Note:   If you do not type a search request, the Search B ook or      ¦
 ¦           Search Book (Extended) dialog box appea rs.                   ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦ READIBM shelfname  /f  search request                                     ¦
 ¦                                                                        ¦
 ¦    Opens the named bookshelf and searches for the  words or phrases     ¦
 ¦    specified in the search request.                                    ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦    Note:   If you do not type a search request, the Search M ultiple     ¦
 ¦           Books or Search Multiple Books (Extende d) dialog box         ¦
 ¦           appears.                                                     ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦ READIBM bookname  /gt  topicID                                            ¦
 ¦                                                                        ¦
 ¦    Opens the named book to the topic ID  specified.                     ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦ READIBM bookname  /p                                                     ¦
 ¦                                                                        ¦
 ¦    Opens the named book and prints the entire boo k.                    ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 ¦                                                                        ¦
 +-------------------------------------------------- ----------------------+
 Figure 2. Startup Commands for Library Reader for W indows
  
  

Related Topics:
  

       In this book:
  

           "Startup Paths" in topic 51.0
            "Startup Windows" in topic 52.0
            "File Extensions" in topic 14.0
  

       In the User's Guide:
  

           Procedures for starting Library Reader for Windows
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 51.0 Startup Paths
  

A startup path defines for your system certain locations needed by Library Reader for Windows at startup.  Initially defined at installation, 
 Library Reader for Windows uses two startup paths:
  
�   Startup path for bookshelves and books, from which Library Reader for Windows finds and displays a list of bookshelves or books in a 

     startup window
  
�   Startup path for notes, which specifies where Library Reader for Windows stores any electronic notes you attach to softcopy books

  
  
  

Startup path for bookshelves and books
        A benefit of the startup path for bookshelves and books is that it allows you to dispense with the need for providing a fully qualified file 
        name to identify a needed file for the system.  The fully qualified file name is a file's complete identification, including its location (drive 
        and subdirectories), as well as its file name and file extension.
  

       For the following functions, whenever the fully qualified file name for a selected file (or group of files) is not available to the system, the 
        system searches each drive and directory specified in the startup path for the selected file or files:
  

       �   Initial display of any startup window
  

       �   Refreshing the list of bookshelves or books in any startup window
  

       �   Opening directly to a bookshelf or book using the Windows Run command
  

       �   Creating a bookshelf
  
  

       The entire path can consist of only a single drive and directory specification, or it can include several specifications.  The value of 
        having several specifications in the startup path is that you can list bookshelves or books residing in a number of locations, rather 
        than in just one.
  

Startup path for notes
        The startup path for notes specifies where Library Reader for Windows stores any electronic notes you attach to softcopy books. If, 
        at installation, default values were used, Library Reader for Windows will store your notes in the program files directory. However, you 
        can specify that notes be stored in any drive and directory to which you have write access.
  
  
  

Related Topics:
  

       In this book:
  

           "Starting BookManager Library Reader for Windows" in topic 50.0
            "Startup Windows" in topic 52.0
            "Notes" in topic 28.0
            "File Extensions" in topic 14.0
  

       In the User's Guide:
  

           Procedures for modifying startup defaults at installation
            Procedures for changing startup defaults from the Options menu
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 52.0 Startup Windows
  

At startup, BookManager Library Reader for Windows takes you to one of three windows, depending on how you choose to start the 
 application:
  
�   List of Bookshelves (the default, without startup options)

 �   Bookshelf
 �   Book
  

From startup windows, you begin your access to the task you want to perform.
  

Related Topics:
  

       In this book:
  

           "Starting BookManager Library Reader for Windows" in topic 50.0
            "Startup Paths" in topic 51.0
  

       In the User's Guide:
  

           Procedures for starting Library Reader for Windows
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 53.0 Status Bar
Located at the bottom of some windows, the status bar displays information about the contents of the window.  For example, the status 

 bar on a List of Bookshelves window displays information about the contents of the list of bookshelves.  Also, windows having a status bar 
 display a brief explanation of a menu command when you select the command.
  

Note:   After a book search from the Book window, the status bar displays an index entry found as a search match when the topic line 
        containing that index entry is visible in the Book window.
  

The BookManager Library Reader for Windows default is to display the status bar.  To temporarily deactivate the status bar for the active 
 window, choose the View menu and deselect Status bar.  Closing the active window restores the status bar.  Alternatively, reactivate the 
 status bar by choosing the View menu again and selecting Status Bar.
  

For information about permanently deactivating the status bar, see "Options Menus" in topic 30.0.
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 54.0 Tool Bar
  

Located at the top of a Book window (just below the menu bar), the tool bar contains icons that serve as shortcuts for commands.
  

The BookManager Library Reader for Windows default is to display the tool bar.  To temporarily deactivate the tool bar for the active 
 window, choose the View menu and deselect Tool Bar.  Closing the active window restores the tool bar.  Alternatively, reactivate the tool 
 bar by choosing the View menu again and selecting Tool Bar.
  

For information about permanently deactivating the tool bar, see "Options Menus" in topic 30.0.
  

Related Topics:
  

       In the User's Guide:
  

           Description of the tool bar
  

       In the Quick Reference:
  

           List of tool bar icons
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 55.0 Type of Search
  

The type of search match affects the processing of search requests.  It determines how closely a word or phrase in text must 
 correspond to the word or phrase in the search request.  You can make your searches as specific or as general as you like.
  

BookManager Library Reader for Windows offers two types of searches:  an exact-match search and a fuzzy-match search.
  
  
�   When you request Exact Match, Library Reader for Windows matches your search request word for word, without regard for 

     capitalization.
  

    Note:   If you want capitalization honored in your search request, select the Case-Sensitive check box.
  
  
�   When you request Fuzzy Match (the default), Library Reader for Windows searches for the words that you specified in your search 

     request, as well as for different forms of those words.  For example:
  

    -   Words that have different endings
     -   Words that have different tenses (past, present, and future)
     -   Words that have different capitalization
     -   Words that have different punctuation
     -   Words that are singular or plural
  

    For example, in a fuzzy-match search:
  

    -   A word matches any other word that shares the same language root: party matches parties , and both is and are match be.  The 
         only exception to this rule concerns the use of a wildcard character to replace letters at the end of a word:  a match for parti*  would 
         be parties (and partisan and every other word that starts with parti); but party is not a match.
  

    -   A period followed by spaces matches any sentence delimiter: matches for house.  include house., house,, and house!.
  
  

    A fuzzy-match search also allows as many as five intervening words between individual words in the search request.  Furthermore, a 
     fuzzy-match search allows resequencing of words in the search request. For example, assume that you request Fuzzy Match on the 
     phrase my forest cottage :
  

    -   My forest cottage is a search match.
     -   my enchanted-forest cottage is a search match.
     -   my enchanting cottage in the forest is a search match.
     -   my cute new enchanting little three-bedroom yellow forest cottage is not a search match.
  
  

Note:   A fuzzy-match search is the only type of search that you can request on multiple-book searches.
  

For information about how to permanently change the defaults, see "Options Menus" in topic 30.0.
  

Related Topics:
  

       In this book:
  

           "Search Request" in topic 43.0
            "Where to Search" in topic 59.0
            "How to Show Results" in topic 20.0
            "Wildcard Characters" in topic 60.0
  

       In the User's Guide:
  

           Procedures for using an extended search dialog box
            Procedures for specifying the type of search
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 56.0 User Exits
  

You can write routines, in the form of dynamic link libraries (DLLs), for monitoring certain BookManager Library Reader for Windows 
 activities. Library Reader for Windows provides three user exits for monitoring purposes:
  
�   Open book

 �   Close book
 �   Expand search
  
  

Open book exit
        Library Reader for Windows invokes the open book exit only when the user opens a book from the Book window.  Information passed 
        to the exit includes:
  

       �   Book name
        �   Build date
        �   Book title
        �   Document number
        �   path/filename.ext, the fully qualified file name of the book file
  

Close book exit
        Library Reader for Windows invokes the close book exit only when the user closes a book opened from the Book window.  Information 
        passed to this exit is the same as that passed to the open book exit:
  

       �   Book name
        �   Build date
        �   Book title
        �   Document number
        �   path/filename.ext, the fully qualified file name of the book file
  

Expand search exit
        Library Reader for Windows invokes the expand search exit when the user issues a search request.  It passes the search request to 
        the exit, allowing for search-request expansion, synonym addition, or request monitoring.  Valid search requests must be returned, or 
        the search might fail.
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 57.0 User Profile
  

Your user profile contains default settings for:
  
�   Search options for both book searches and multiple-book searches

 �   Color options for displaying book text
 �   Font options for displaying book text
 �   Workspace options for activating and deactivating the tool bar, the status bar, and--when opening a book--the Topics window
 �   Path options for notes files and for startup
 �   Confirmation options for exiting Library Reader for Windows
  

The commands available on Options menus let you make permanent changes to these defaults.
  

Note:   Changes made in menus other than Options (as well as in dialog boxes) act as temporary changes and remain active only as long 
        as the book is open.
  
  

Related Topics:
  

       In this book:
  

           "Options Menus" in topic 30.0
  

       In the User's Guide:
  

           Procedures for changing search options
            Procedures for changing colors
            Procedures for changing fonts
            Procedures for changing workspace options
            Procedures for changing startup defaults
            Procedures for changing confirmation options

BookManager Library Reader for Windows: Online Refe rence
User Profile

¦ Copyright IBM Corp. 1989, 1994
57.0 - 1



 58.0 View Menus
  

Table 12 compares the various Library Reader for Windows View menus. Notice that commands available on a View menu vary, 
 depending on where you are in the application.  For all menu commands, Library Reader for Windows offers:
  
�   Context-sensitive help, which describes the purpose and use of the command

  
�   Short help, which displays (in the status bar) a one-line description of the command

  
  
  
 Table 12. Comparison of View Menus
 from List of Bookshelves                     from List of Books
  
 View                                        View
     Status Bar                                  Status Bar
     ---------------------------------           --- ----------------------------
     I nclude                                     I nclude  
         By Name...                                  By Name...
         By Title...                                 By Title...
         Selected                                    Selected
         All                                         All
     Sort                                        Sort  
         Name                                        Name
         Date                                        Date
         Title                                       Title
     Refresh                Ctrl+Shift+R             Do cument Number
                                                 Refresh             Ctrl+Shift+R
  
 from Bookshelf                               from Book
  
 View                                        View
     Status Bar                                  Tool Bar
                                                 Sta tus Bar
     ----------------------                      Sho w Pictures in Text
     I nclude  
         By Name...                              --------------- ----------------
         By Title...                             E xpand All                Ctrl+*
         Selected                                Collapse All              Ctrl+-
         All
     Sort  
         Name
         Date
         Title
         Do cument Number
     Refresh Ctrl+Shift+R
  
 from Picture                                 from Topics
  
 View                                        View
     Size Picture to Window                      E xpand All
     Zoom In       Ctrl+Z                        Collapse All
     Zoom Out
     AutoZoom
     ------------------
     Restore
  
 from Search Results
  
 View
     Details
     Topics Only
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 59.0 Where to Search
  

You identify areas to search in the Search Book (Extended) dialog box. You access this dialog box by choosing the Extended button on 
 the Search Book dialog box (accessed from the Book window's Search menu).
  

You can search a book across a combination of different areas:
  
�   Selecting Topic Text requests a search for the word or phrase in the text of topics.

  
�   Selecting Topic Titles requests a search for the word or phrase in the titles of topics.

  
�   Selecting Indexed Words requests a search for the word or phrase in the list of indexed entries.

  
  

Note:   You must select at least one area.  Selecting all areas (the default and only option in a multiple-book search) requests a search 
        across the entire book.
  
  

Related Topics:
  

       In this book:
  

           "Search Request" in topic 43.0
            "Type of Search" in topic 55.0
            "How to Show Results" in topic 20.0
            "Search Results Ranking" in topic 45.0
  

       In the User's Guide:
  

           Procedures for using an extended search dialog box
            Procedures for specifying where to search
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 60.0 Wildcard Characters
  

You can use wildcard characters in your search request to replace characters when you want to find text that matches a given pattern. 
 Library Reader for Windows offers two wildcard characters:
  
�   A multiple-character wildcard--the asterisk (*)--which substitutes for one or more characters in a search request.  You can type it at 

     the front, center, or end of a word.  For example, if you wanted to find all the occurrences of words that begin with dog, you would enter 
     the search request as dog* .  Library Reader for Windows would find search matches on such words as:
  

        doghouse
         dogcatcher
         dogie
         dogma
  

    In this example, the asterisk (*) serves as a wildcard character, meaning that it substitutes for all possible endings in words that begin 
     with dog.
  
�   A single-character wildcard--the question mark (?)--which substitutes for only one character in a search request.  Like the 

     multiple-character wildcard, you can type it at the front, center, or end of a word.  For example, a search request for c?t  would find 
     search matches on such words as:
  

        cat
         cot
         cut
  
  

Note:   Extended search dialog boxes provide buttons that, when chosen, insert operators (including wildcard characters) into the Search 
        Request text box.  You complete the search request by typing the words or phrases into the text box.  For more information about the 
        buttons and how they relate to the insertion point, refer to the User's Guide.
  
  

Related Topics:
  

       In this book:
  

           "Word or Phrase Separator" in topic 63.0
            "Boolean Operators" in topic 10.0
            "Grouping Operators" in topic 18.0
            ""As Is" Operators" in topic 1.0
  

       In the User's Guide:
  

           Procedures for using wildcard characters in a search request
            Procedures for using command buttons to enter Boolean operators and symbols
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 61.0 Window Menus
  

As shown in Table 13, the first item in a Window menu is a Close All command, followed by a sequential list of windows opened during the 
 session.
  
 Table 13. Window Menu
 from List of Bookshelves , List of Books , Bookshelf , or Book
  
 Window
     Close All
     ---------------------------------
     (numbered list of open windows)
  
  

When you choose Window from the Book window, all windows opened from the Book window are listed in same sequence they were 
 opened.  For example:
  

1.  MyBKSName:My Bookshelf Title
 2.  MyNewName:My Other Bookshelf Title
 3.  MyBKSName:My Bookshelf Title
 4.  BOOKSHELF:d:\path\filename.ext
 5.  BOOK:d:\path\filename.ext
  

When you choose Window from the List of Bookshelves window, the List of Books window, or the Bookshelf window, a sequential list of up 
 to nine windows is displayed.  If you opened more than nine windows from any of these windows (identified when a More Windows 
 command appears in the Window menu), a list box is available for viewing the remainder.
  

If you opened the same window more than once, each instance is reflected as a separate entry.  Choosing an entry links you to that 
 window.
  

Choosing Close All closes all the windows listed.
  

Related Topics:
  

       In the User's Guide:
  

           Procedures for listing or closing windows opened from Book
            Procedures for listing or closing windows opened from List of Bookshelves
            Procedures for listing or closing windows opened from List of Books
            Procedures for listing or closing windows opened from Bookshelf
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 62.0 Word Check
  

When you select the Word Check button for a word in a search request, Library Reader for Windows looks for variations of that word 
 already in the book or bookshelf and displays a Word Check window that lists the variations it finds.  From this window, you can choose:
  
�   Replace (the default) to replace the current search word with the word you select from the list

  
�   Cancel to close the Word Check window, making no change to the current search word

  
  

Note:   Library Reader for Windows permits a word check on multiple books only when the books are on the same bookshelf and a 
        bookshelf search index for those books exists.
  
  

Related Topics:
  

       In this book:
  

           "Boolean Operators" in topic 10.0
            "Wildcard Characters" in topic 60.0
  

       In the User's Guide:
  

           Procedures for checking search words for spelling variations
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 63.0 Word or Phrase Separator
  

You use a word or phrase separator to separate words and phrases in a single search request.  A comma is Library Reader for 
 Windows' word or phrase separator.  For example:
  
�   puma, jaguar  (separating two words)

 �   puma, jungle cat  (separating a word from a phrase)
  

BookManager Library Reader for Windows processes word or phrase separators the same way it processes Boolean or operators--a 
 topic containing either word (or phrase) qualifies as a search match.
  

Note:   Extended search dialog boxes provide buttons that, when chosen, insert operators (including the word or phrase separator) into 
        the Search Request text box.  You complete the search request by typing the words or phrases into the text box.  For more 
        information about the buttons and how they relate to the insertion point, refer to the User's Guide.
  
  

Related Topics:
  

       In this book:
  

           "Wildcard Characters" in topic 60.0
            "Boolean Operators" in topic 10.0
            "Grouping Operators" in topic 18.0
            ""As Is" Operators" in topic 1.0
  

       In the User's Guide:
  

           Procedures for using command buttons to enter Boolean operators and symbols
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 GLOSSARY Glossary of Terms and Abbreviations
This glossary defines all new terms and abbreviations used in this document.  If you do not find the term you are looking for here, refer to 

 the index of this document or to the IBM Dictionary of Computing, SC20-1699.  Any terms in this book that were derived from the following 
 sources are identified by the symbols indicated:
  
�   The American National Standard Dictionary for Information Systems, ANSI X3.172-1990, copyright 1990 by the American National 

     Standards Institute (ANSI).  Copies can be purchased from the American National Standards Institute, 1430 Broadway, New York, New 
     York 10018. Definitions are identified by the symbol (A) after the definition.
  
�   The Information Technology Vocabulary, developed by Subcommittee 1, Joint Technical Committee 1, of the International Organization 

     for Standardization and the International Electrotechnical Commission (ISO/IEC JTC1/SC1).  Definitions of published parts of this 
     vocabulary are identified by the symbol (I) after the definition; definitions taken from draft international standards, committee drafts, and 
     working papers being developed by ISO/IEC JTC1/SC1 are identified by the symbol (T) after the definition, indicating that final agreement 
     has not yet been reached among the participating National Bodies of SC1.
  
�   The Microsoft Windows User's Guide, copyright 1990-1992 by the Microsoft Corporation.  Definitions taken from the User's Guide 

     glossary are identified by the symbol (W) after the definition.
  
  

The following cross-references are used in this glossary:
  

Contrast with   This refers to a term that has an opposite or significantly different meaning.
  

See            This refers you to a phrase in which this term appears.
  

See also        This refers you to terms that have a related but not synonymous meaning.
  

Synonym for     This indicates that the term has the same meaning as a preferred term, which is also defined.
  
  
  
  
    +--------------------+
    ¦ Special Characters  ¦
    +--------------------+
  
  

*.  (1) The symbol used as a substitute for one or more letters in a book or bookshelf name when listing books or bookshelves.  (2) The 
 symbol used as a substitute for one or more letters in a word when defining a search request.  See also wildcard.
  
  

?.  (1) The symbol used as a substitute for one letter in a book or bookshelf name when listing books or bookshelves.  (2) The symbol 
 used as a substitute for one letter in a word when defining a search request.  See also wildcard.
  
  

&.  In Boolean searching, an operator you enter in a search request to connect two words or phrases with an AND relationship.  Contrast 
 with | and !.  See also AND, Boolean, search request, and operator.
  
  

|.  In Boolean searching, an operator you enter in a search request to connect two words or phrases with an OR relationship.  Contrast 
 with & and !.  See also Boolean, AND, search request, and operator.
  
  

!.  In Boolean searching, an operator you enter in a search request to connect two words or phrases with a BUT NOT relationship.  
 Contrast with & and |.  See also Boolean, AND, search request, and operator.
  
  
    +---+
    ¦ A ¦
    +---+
  
  

access .  To obtain the use of a computer resource. (T)
  
  

action .  A defined task that Library Reader for Windows performs.  You initiate an action by doing any of the following:
  
�   Choosing a menu command

 �   Choosing a command button
 �   Pressing a function key
 �   Pressing a shortcut key
 �   Typing a command
  
 See also  choose ,  menu command ,  command button ,  function key ,  shortcut key ,
 and  command .
  
  

activate .  (1) To make a window, bookshelf, book, topic, tool bar, or status bar visible and ready for use.  (2) To cause changes that you 
 have made to options to take effect.
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active .  The window or icon that you are currently using or that is currently selected.  Only one window or icon can be active at a time. 
 Keystrokes and commands affect the active window or icon.  If a window is active, its title bar changes color to differentiate it from other 
 windows.  If an icon is active, its label changes color.  Windows or icons on the desktop that are not selected are inactive.  (W)
  
  

active window .  The window that can receive input from the keyboard, which is the window with which you are currently interacting, or the 
 last window that was activated.  The active window is indicated by a title bar and border in a different color or shade from all other 
 windows.  Contrast with inactive window.  See also title bar.
  
  

Advanced Function Printing (AFP) .  A set of licensed programs or user applications that permits all-points-addressable printing of text 
 and graphics on a page printer.
  

AFP.  See Advanced Function Printing (AFP).
  
  

AIX BookManager READ/6000 .  An IBM licensed program that lets you display, search, organize, and make notes in softcopy 
 documents on a programmable workstation running the AIX operating system.
  
  

American National Standard Code for Information Int erchange (ASCII) .  The standard code, using a coded character set consisting 
 of 7-bit coded characters (8 bits including parity check), that is used for information interchange among data processing systems, data 
 communication systems, and associated equipment.  The ASCII set consists of control characters and graphic characters. (A)
  
  

AND.  In Boolean searching, the relationship expressed by the & operator when used to connect two words or phrases in a search 
 request.  When connected by an AND relationship, both words or phrases must be present for the topic to be considered a match.  
 Contrast with OR and BUT NOT. See also &, Boolean, search request, and operator.
  

API.  See application programming interface (API).
  
  

application .  (1) A collection of software components used to perform specific types of work on a computer.  (2) A program written for or 
 by a user that applies to the user's work, such as a program that does inventory control or payroll.
  
  

application programming interface (API) .  (1) A functional interface supplied by the operating system or by a separately orderable 
 licensed program that allows an application program written in a high-level language to use specific data or functions of the operating 
 system or the licensed program.  (2) The interface through which an application program interacts with an access method.
  

arrow keys .  Synonym for cursor movement keys.
  
  

"as is" operators .  In a search request, the symbols used to specify that an operator symbol be treated as text, and not as an operator.  
 In Library Reader for Windows, the "as is" operators are single quotes.
  

ASCII.  See American National Standard Code for Information Interchange (ASCII).
  

asterisk .  Synonym for *.
  
  

author .  The person who wrote or prepared the information in a BookManager softcopy document.
  
  

autozoom .  A picture function that lets you automatically enlarge (zoom in on) a portion of a picture that you have selected using the 
 mouse.  When the autozoom function is on, you can select the picture portion and zoom in on it in one step.  See also zoom in.
  
  

available choice .  A menu command that you are able to use.  Available choices are not dimmed.  Contrast with unavailable choice.  See 
 also dimmed.
  
  
    +---+
    ¦ B ¦
    +---+
  
  

back matter .  Topics that are placed after the main chapters or topics in a book.  Back matter often includes a glossary, a bibliography, 
 and an index.
  
  

backward .  A scrolling direction in which book text or list items move downward, so that the text or items above come into view.  Contrast 
 with forward.  See also page up.
  
  

book .  In BookManager, a softcopy document, created by BookManager BUILD, that can be read and searched at a display device using 
 BookManager READ. A softcopy book often has the traditional structure of a printed book, including standard book elements such as a 
 cover page, table of contents, chapters, and an index.  See also book metaphor, document, BookManager BUILD, and BookManager 
 READ.
  

BookManager Library Reader for Windows: Online Refe rence
Glossary of Terms and Abbreviations

¦ Copyright IBM Corp. 1989, 1994
GLOSSARY - 2



  
Book Description window .  A window that provides information about a book, such as the book's title, author, publication date, and 

 document number.
  

book file name .  Synonym for book name.  See also file name.
  
  

book metaphor .  A conceptual model for presenting softcopy information. The book metaphor helps BookManager softcopy to simulate 
 the look and feel of a printed book.
  
  

book name .  The file name of a softcopy book.  See also file name.
  
  

book search .  A search done within a single book, on selected topics or on the entire book.  Results of a book search are optionally 
 displayed in a Search Results window.  Search matches are emphasized in the book text. See also search, search results, search match, 
 and search ranking. Contrast with multiple-book search.
  
  

book session .  The period of time during which a book is displayed in a Book window.  When more than one book is open at the same 
 time, there is a separate ongoing book session for each.  See also Library Reader for Windows session.
  
  

book text .  The information contained in a softcopy book that is displayed in the left side of a Book window.
  
  

Book window .  The window in which the text of a softcopy book is displayed.
  
  

BookManager .  A family of IBM licensed programs that lets users create and display softcopy.  See BookManager BUILD and 
 BookManager READ.
  
  

BookManager BUILD .  A generic reference to several similar IBM licensed programs that let you create softcopy on different operating 
 systems from source files in different formats.  See BookManager BUILD/2, BookManager BUILD/MVS, and BookManager BUILD/VM.  
 Contrast with BookManager READ.
  
  

BookManager BUILD/2 .  An IBM licensed program that lets you create softcopy on an OS/2 system from word processor documents or 
 plain ASCII files.
  
  

BookManager BUILD/MVS .  An IBM licensed program that lets you create softcopy on an MVS host system from tagged source 
 materials (known as data sets).
  
  

BookManager BUILD/VM .  An IBM licensed program that lets you create softcopy on a VM host system from tagged source files.
  
  

BookManager READ .  A generic reference to several similar IBM licensed programs that let you read and search softcopy created using 
 IBM BookManager BUILD.  See BookManager Library Reader for Windows, BookManager READ/DOS, BookManager READ/2, AIX 
 BookManager READ/6000, BookManager READ/VM, and BookManager READ/MVS.  Contrast with BookManager BUILD.
  
  

BookManager READ/2 .  An IBM licensed program that lets you display, search, organize, and make notes in softcopy books on a 
 programmable workstation running the OS/2 operating system.
  
  

BookManager READ/DOS .  An IBM licensed program that lets you display, search, organize, and make notes in softcopy books on a 
 programmable workstation running the DOS operating system.
  
  

BookManager Library Reader for Windows .  An IBM licensed program that lets you display, search, organize, and make notes in 
 softcopy books on a programmable workstation running the Microsoft Windows operating system.
  
  

BookManager READ/MVS .  An IBM licensed program that lets you display, search, organize, and make notes in softcopy books on an 
 MVS host system.
  
  

BookManager READ/VM .  An IBM licensed program that lets you display, search, organize, and make notes in softcopy books on a VM 
 host system.
  
  

bookmark .  In BookManager, a placeholder that you can add to a softcopy book.  For each open book, there is one bookmark that you 
 can place, find, or remove at any time.
  
  

BookMaster .  An IBM licensed program that provides a generalized markup language used to tag a text source file so that it can be 
 formatted using the Document Composition Facility (DCF).  BookMaster is primarily used for developing technical publications.  It offers a 
 richer tag vocabulary than the GML Starter Set that is available with DCF.  See also Document Composition Facility (DCF) and 

BookManager Library Reader for Windows: Online Refe rence
Glossary of Terms and Abbreviations

¦ Copyright IBM Corp. 1989, 1994
GLOSSARY - 3



 generalized markup language (GML).
  
  

bookshelf .  (1) In BookManager, a logical grouping of softcopy books that allows them to be organized for convenience and for faster 
 searching. (2) A file (with an extension of .BKS) that contains the definition of a bookshelf.
  
  

Bookshelf Description dialog box .  A dialog box that describes a bookshelf.  Elements of the description include the bookshelf name, 
 date last updated, the number of books and bookshelves contained within the bookshelf, the location of the search index, and the location 
 of the bookshelf itself.
  
  

bookshelf file name .  A name for a file with an extension of .BKS, which contains the definition of a bookshelf.  The file name must 
 conform to DOS conventions for naming files and does not have to be the same as the bookshelf name.  Contrast with bookshelf name 
 and bookshelf title.  See also bookshelf.
  
  

bookshelf name .  The BookManager name assigned by the creator of a bookshelf for the bookshelf.  Bookshelf name is created by 
 typing the name in the Create Bookshelf Information dialog box and can be viewed in the Bookshelf Description dialog box.  Contrast with 
 bookshelf file name and bookshelf title.  See also bookshelf.
  
  

bookshelf search index .  Synonym for search index.
  
  

bookshelf title .  The title assigned by the creator of a bookshelf for the bookshelf.  Bookshelf title is created by typing the title in the Create 
 Bookshelf Information dialog box and can be viewed in the Bookshelf Description dialog box or List of Bookshelves window.  It can be up to 
 255 characters in length.  Contrast with bookshelf file name, and bookshelf name.  See also bookshelf.
  
  

Bookshelf window .  A window that lists all the books on a bookshelf.
  
  

Boolean .  A process where combinatorial relationships are established between elements and the result takes on one of two values.  In a 
 Boolean operation, each of the elements may be assigned a value, such as 0 or 1, true or false.  The elements may then be combined in 
 Boolean expressions, using Boolean operators to establish the relationship between the elements.  This evaluation can take place in a 
 truth table, which shows the logical outcome of evaluating the expression for all possible cases. See also Boolean search.
  
  

Boolean operators .  The &, |, and !  characters that can be used to join two search words together such that both words, one or the 
 other, or one but not the other, are found in the text to satisfy the search request.
  
  

Boolean search .  A search method that uses Boolean processing to analyze search matches.  Boolean operators are used in a search 
 request to make a Boolean expression.  See also Boolean, AND, &, OR, |, BUT NOT, and !.
  
  

box .  Synonym for text box.
  

build a book .  To use BookManager BUILD to create a softcopy book from source files.  See also BookManager BUILD.
  
  

BUT NOT.  In Boolean searching, the relationship expressed by the ! operator when used to connect two words or phrases in a search 
 request. When connected by a BUT NOT relationship, the word or phrase to the left of the ! must be present and the word or phrase to 
 the right of the ! must not be present for the topic to be considered a match.  Contrast with AND and OR.  See also !, Boolean, search 
 request, and operator.
  
  

button .  Synonym for command button.
  
  
    +---+
    ¦ C ¦
    +---+
  
  

cancel .  To remove the current window or menu without processing it, and return to the previously active window.
  
  

cascading menu command .  A command on a menu that produces a cascading menu containing more commands.  A cascading menu 
 command is indicated by a right arrowhead next to it.
  
  

cascading menu .  A menu that opens from a command on another menu.  A command that opens a cascading menu has a right arrow 
 next to it. (W)
  

case .  The characteristic of a letter that determines whether it is a capital letter or a small letter.  Case is generally referred to as 
 uppercase, lowercase, and mixed case.
  
  

Case-Sensitive .  A search option that causes uppercase and lowercase letters to be searched for as if they were identical.  For 
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 example, when Case-Sensitive is selected, a search for OK would find OK, Ok, and ok. See also search.
  

CD-ROM.  See compact disc-read only memory (CD-ROM).
  

chapter .  In BookManager, a section or part of a softcopy book whose topic ID begins with a major topic number, such as 1.0 or 4.0.  See 
 also topic identifier.
  
  

character .  Any letter, number, ideogram, or other symbol used for the organization, control, or representation of data.
  
  

check box .  A small, square box that appears in a dialog box and that can be selected or cleared.  When the check box is selected, an X 
 appears in the box.  A check box represents an option that you can turn on or off. (W)
  

check mark .  A symbol used next to a menu command to indicate that the command is in effect.  For example, when a check mark 
 appears next to the Tool Bar menu command, it indicates that the tool bar is visible.
  
  

choose .  To use a mouse or keyboard to pick an item that begins an action in Windows.  You choose commands on menus to perform 
 tasks, and you choose icons to start applications. (W)  Contrast with select.
  
  

clear .  To turn off an option by removing the X from a check box.  You clear a check box by clicking it, or selecting it and pressing the 
 Spacebar. (W)  Contrast with select.  See also check box, click, and deselect.
  
  

click .  To press and release a mouse button quickly. (W)  Contrast with double-click.
  
  

Clipboard .  A temporary storage location used to transfer data between documents and applications.  Typically, you transfer data to the 
 Clipboard by using an application's Copy or Cut command, and you insert data from the Clipboard by using the application's Paste 
 command.  You can use the Windows Clipboard Viewer to view the contents of the Clipboard. (W)
  
  

close .  To remove a window or dialog box, or quit an application.  You can close a window by using the Close command on the Control 
 menu.  When you close an application window, you quit the application. (W)
  
  

close book exit .  A user exit that enables a site to monitor when a softcopy book is closed.  Library Reader for Windows invokes this exit 
 whenever an open book currently displayed in a Book window is being closed.  See also open book exit, search expansion exit, user exit, 
 and close.
  
  

code page .  An assignment of graphic characters and control function meanings to all code points; for example, assignment of 
 characters and meanings to 256 code points for an 8-bit code.  See also code point.
  
  

code point .  A 1-byte code that represents one of the potential characters in a code page.  See also code page.
  
  

collapse .  To click on the icon (-) next to a topic title, thereby causing the titles of all its subtopics to be hidden from view.  See also 
 subtopic and click.
  
  

command .  A word or phrase, usually found in a menu, that you choose in order to carry out an action.  You choose a command from a 
 menu, or type a command at the DOS prompt. (W)  See menu command.
  
  

command button .  In a dialog box, a button that carries out an action.  A command button often has a label that describes the action it 
 carries out (for example, Cancel, Help, or Install).  Choosing a command button that is followed by an ellipsis (for example, Describe...) 
 causes another dialog box to appear. (W)
  
  

command prompt .  Synonym for DOS prompt.
  
  

compact disc-read only memory (CD-ROM) .  High-capacity, read-only memory in the form of an optically read compact disc.
  
  

confirmation message .  A message that appears after you specify certain actions, prompting you to confirm that you want to continue 
 with the action or to specify that you want to cancel it. (W)
  
  

contents help .  Help for an entire window that describes the window's selections and how they relate to one another.  Contrast with 
 context-sensitive help, short help, and message help.  See also click.
  
  

context-sensitive help .  Online help information for a specific tool bar icon or menu command.  You can display context-sensitive help by 
 pressing SHIFT+F1, or by using mouse button 1 to click the Help icon in the tool bar and then clicking the command or tool bar icon for 
 which you want help.  Contrast with contents help, short help, and message help.  See also click.
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Control menu .  A menu that contains commands you can use to manipulate the window.  Application icons and some dialog boxes also 
 have a Control menu. To open the Control menu, you use the Control-menu box at the left of the title bar in a window, or you select an 
 application icon.  See also Control-menu box. (W)
  
  

Control-menu box .  The icon that opens the Control menu for the window. It is always at the left of the title bar. (W)
  
  

copy .  (1) To create and store in a disk file, a duplicate of information from a softcopy book.  (2) To put a copy of the selected text or item 
 onto the Clipboard so that you can transfer it to another location.  Most Windows applications have a Copy command on the Edit menu 
 that performs this task. (W)
  
  

cross-book link .  A link that takes you from one softcopy book to another softcopy book in the same bookshelf or List of Books.  Contrast 
 with intra-document link.  See also hypertext link.
  
  

cross-reference link .  Emphasized text you can select to display the topic, figure, table, or text being referenced.  For example, the 
 reference Table 1 displays Table 1 when you double-click the reference, or move the cursor to the reference and press Enter.  See also 
 cross-book link and hypertext link.
  
  

current directory .  The directory that you are currently working in. (W)
  
  

current topic .  The topic that is displayed in the left side of the Book window.
  
  

cursor .  Synonym for insertion point and selection cursor.
  
  

cursor movement keys .  The �,  , �, and � keys on the keyboard that move the cursor in the directions that the arrows point.  Also 
 known as arrow keys.
  
  

cut .  To move data from a document into a temporary storage area called the Clipboard.  Most Windows applications have a Cut 
 command (on the Edit menu) that performs this task. (W)
  
  
    +---+
    ¦ D ¦
    +---+
  
  

Date Built .  The date a softcopy book was built using a BookManager BUILD product or the date a bookshelf was created.
  
  

Date Published .  The date an author includes in a book when the draft is finalized.
  
  

default .  A value used by Library Reader for Windows when you have not explicitly specified one.  Some default values are shipped with 
 Library Reader for Windows, and some may have been set by you or whomever installed Library Reader for Windows for you.  Default 
 values can usually be changed.  For example, the installation program allows you to specify a default startup path for notes; you can 
 change this default value using the Startup Defaults menu command on any Options menu.
  
  

default button .  In some dialog boxes, the command button that Windows automatically selects.  The default button has a bold border, 
 indicating that it will be chosen if you press Enter.  You can override a default button by choosing Cancel or another command button. (W)
  
  

delete .  To permanently erase an object from disk storage.  After deleting the object, you will not be able to use it again without recreating 
 it. Contrast with remove.
  
  

deselect .  To remove an item from a selection.  Contrast with select and mark.
  
  

desktop .  The screen background for Windows on which windows, icons, and dialog boxes appear. (W)
  
  

dialog box .  A window that appears temporarily to request information. Many dialog boxes have options you must choose before 
 Windows can carry out a command. (W)
  
  

dimmed .  Unavailable or disabled.  A dimmed button or command is displayed in light gray instead of black, and it cannot be chosen. (W)
  
  

directory .  An ordered or classified list used to find the locations of things, such as files.  A directory that is part of another directory is a 
 subdirectory.
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disk .  A medium for storing information.  Information stored on a disk remains there even when you turn your computer off, unlike 
 information stored in memory (RAM).  A floppy disk can be inserted and removed from a floppy disk drive, whereas a hard disk is 
 permanently mounted inside its drive. (W)  Contrast with random access memory (RAM).  See also disk drive.
  
  

disk drive .  A device used for storing and retrieving information on disks. (W)  See also disk.
  
  

document .  Whatever you create with an application, including information you type, edit, view, or save.  A document may be a business 
 report, a spreadsheet, a picture, or a letter, for example, and is stored as a file on a disk. (W)
  
  

Document Composition Facility (DCF) .  An IBM licensed program that prepares files for printing or softcopy display with BookManager.
  
  

document element .  A standard, distinct part of a softcopy or hardcopy document.  Document elements include paragraphs, headings, 
 tables, figures, and so on.
  
  

document markup language .  A language used to define information to be added to the content of a document to enable a person or 
 system to process it.  It can describe the characteristics of the document or specify actual processing to be performed.
  
  

document number .  The form number of a manual that can be used to order copies of the manual.  The document number for softcopy 
 is displayed in the book description and can be displayed on the bookshelf.
  
  

documentation directory .  The directory in which you tell Library Reader for Windows to store the product's softcopy books during 
 installation, and in which you can also store other softcopy books.  C:\BOOKS is a typical documentation directory.  See also directory.
  
  

DOS prompt .  At the DOS command line, the character or characters that appear at the beginning of the line, indicating that the 
 computer is ready to receive input. (W) See also command prompt.
  

DOS share mode .  Synonym for share mode.
  
  

double-click .  To rapidly press and release a mouse button twice without moving the mouse.  Double-clicking carries out an action, such 
 as starting an application. (W)  Contrast with click.
  

down .  See page down.
  
  

download .  To send information from a mainframe computer to an attached personal computer.  Contrast with upload.
  

DPI.  Dots-per-inch.
  
  

drag .  To move an item on the screen by selecting the item and then pressing and holding down the mouse button while moving the 
 mouse.  For example, you can move a window to another location on the screen by dragging its title bar. (W)
  
  

drive .  See disk drive.  See also disk and floppy disk.
  
  

dynamic link library (DLL) .  A file containing executable code and data bound to a program at load time or run time, rather than during 
 linking. The code and data in a dynamic link library can be shared by several applications simultaneously.
  
  
    +---+
    ¦ E ¦
    +---+
  
  

ellipsis .  A symbol (...) used with a menu command to indicate that choosing that command causes a dialog box to appear.
  
  

emphasis .  A means of calling attention to a search match by changing its color.  See also emphasized phrases and search emphasis.
  
  

emphasized phrases .  Phrases in topic text whose color makes them stand out from the rest of the text.  Emphasis means that the 
 phrase is a search match.  See also search match.
  
  

enter .  To submit all selected choices and text box information to the computer for processing; for example, to type information on a 
 keyboard and press Enter.
  
  

Enter key .  A key on a keyboard that, when pressed, causes information to be submitted to a computer for processing.  Note that this key 
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 is sometimes labeled with a bent-arrow symbol.
  

erase .  Synonym for delete.
  
  

error message .  A message that indicates that a problem has occurred.  See also message, information message, and warning 
 message.
  

escape operator .  See "as is" operator.
  
  

exact match .  A word or phrase found by Library Reader for Windows during a book search, that corresponds exactly to the word or 
 phrase typed in the search request.  Contrast with fuzzy match.  See also search request.
  

exclamation point .  See BUT NOT.
  
  

exit .  To end the current Library Reader for Windows session.
  
  

expand .  To click on the + icon next to a topic title, thereby causing the titles of all its subtopics to come into view.  See also subtopic and 
 click.
  
  

extended search dialog box .  Either the Search Book (Extended) or the Search Multiple Books (Extended) dialog box, in which you can 
 perform a word check; enter wildcards, Boolean operators, or other operators into your search request by means of command buttons; 
 or change search options temporarily for the search request.  An extended search dialog box can be made the default dialog box for all 
 book searches or all multiple-book searches or both.  See also word check, wildcard, Boolean operators, operator, search request, book 
 search, and multiple-book search.
  
  

extension .  The period and up to three characters at the end of a file name.  An extension usually identifies the kind of information a file 
 contains.  (W)  For example, a book file has an extension of .BOO, a bookshelf file .BKS, a search index file .BKI, and a notes file .NTF.
  
  
    +---+
    ¦ F ¦
    +---+
  
  

figure .  A vector graphic, image, or other kind of illustration in the text of a document that is identified by a title or caption and a sequential 
 number.
  
  

figure list .  A list in a softcopy or hardcopy book that displays all numbered figures contained in the book.
  
  

FIGURES.  The topic ID of a topic in a softcopy book that contains the list of figures in the book.
  
  

Figures navigator .  A window that lists the figures in a softcopy book and lets you work with them.
  
  

file .  A collection of information treated as a unit.
  
  

file extension .  Synonym for extension.
  
  

file name .  (1) A one- to eight-character name that is used to identify a computer file.  The file name is usually combined with a file 
 extension. See also extension.  (2) The name used by Library Reader for Windows to identify a book or bookshelf file.
  

find .  A function available in certain Library Reader for Windows dialog boxes that lets you list and select books or bookshelves from other 
 directories.  See also directory.
  

fixed disk .  Synonym for disk.
  
  

floppy disk .  A disk that can be inserted in and removed from a floppy disk drive.  (W)  See also disk and disk drive.
  
  

focused search .  A Library Reader for Windows book search that is narrowed to one or more of the following areas:  topic titles, topic 
 text, or indexed words.  See also search options.
  
  

font .  A set of letters, numbers, punctuation marks, and symbols that are a given size and design. (W)
  
  

footnote .  A note of reference, explanation, or comment printed at the bottom of a printed page or shown in a footnote window.
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footnote symbol .  A number or character enclosed in parentheses and appended to the end of a word in a softcopy book.  A footnote 
 symbol is the softcopy equivalent of a superscript number in a printed book. Because a footnote symbol is also a link, you can click on it 
 and view the text of the footnote.  See also footnote, hypertext link, and click.
  
  

forward .  A scrolling direction in which book text or list items move upward, so that the text or items below come into view.  Contrast with 
 backward.  See also page down.
  
  

front matter .  Topics such as the preface, abstract, table of contents, list of figures or list of tables that are placed before the main 
 chapters or topics in a softcopy book.
  
  

function key .  Synonym for shortcut key.
  
  

fuzzy match .  A word or phrase found by Library Reader for Windows during a single-book or multiple-book search, that is a variation the 
 word typed in a search request.  Fuzzy matches are different forms of the same root word.  For example, the words computing and 
 computers would be considered fuzzy matches for the word computer.  Contrast with exact match.  See also search match.
  
  
    +---+
    ¦ G ¦
    +---+
  
  

generalized markup language (GML) .  A document markup language that identifies and describes each document element.
  
  

graphic .  Pertaining to pictorial material or the output of graphics software, in contrast to text.  Graphics in a softcopy book can be 
 integrated in the topic text, or displayed separately in the Picture window.  See also raster image.  Contrast with text.
  

graphics reference link .  A word or phrase in the text of an online book that represents a figure. A user can view the figure in the Picture 
 window by double-clicking on the graphics reference link, or by moving the cursor to the link and pressing Enter.
  
  

grouping operators .  In a search request, the symbols used to change the Boolean operators' default order of precedence.  In Library 
 Reader for Windows, the grouping operators are the left and right parentheses.
  
  

group window .  A window that displays the items in a group within Program Manager.  These items may be applications, accessories, or 
 documents. (W)
  
  
    +---+
    ¦ H ¦
    +---+
  
  

hardcopy .  Printed copies of books, manuals, or other information. Contrast with softcopy.
  

heading .  Words indicating the beginning of a new topic or section.
  

hidden windows .  The open windows arranged behind the active window.
  
  

highlighted .  Indicates that an object or text is selected and will be affected by your next action.  Highlighted text appears in reverse video 
 on monochrome monitors or in color on some color monitors.  Highlighted objects might change color or be surrounded by a selection 
 cursor. (W) See also select, selection cursor, and reverse video.
  
  

horizontal topic text scroll bar .  A bar that appears at the bottom  of the left side of the Book window when the lines of text are too wide 
 to be displayed completely.  The scroll bar can be used to bring the hidden portions of the lines into view.  See also  scroll bar, and topic 
 text scroll bar.
  
  

hypertext .  A method of accessing information in a nonlinear fashion. This methodology is usually implemented by providing places in the 
 text where the reader can link to more information on a particular graphic or idea.
  
  

hypertext link .  An automatic connection between an element in one part of a softcopy book to another element in the same book or to 
 another softcopy book.  The link is a pointer from a location in a softcopy document to another location in the same document.  It lets you 
 move without scrolling or explicitly requesting to go to the new location.  BookManager BUILD automatically creates links from a 
 cross-reference to the referenced location.  Authors can also create hypertext links in a softcopy document, to point you to related 
 information.  See also cross-reference link, cross-book link, and intra-document link.
  
  
    +---+
    ¦ I  ¦
    +---+
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icons .  Graphical representations of various elements in Windows, such as disk drives, applications, embedded and linked objects, and 

 documents. (W)
  

image .  See raster image.  Contrast with vector graphic.
  

ImageMark Software Labs, Inc .  Developer of ImageStream Graphics Filters.
  

ImageStream Graphics Filters .  A trademark of ImageMark Software Labs, Inc.  Graphics filters convert various graphics formats from 
 one to another.
  

importance .  See search results importance.
  
  

inactive window .  An open window with which you are not currently interacting.  An inactive window is not available for user interaction 
 until it becomes active again.  Contrast with active window.  See also open window.
  
  

index .  An alphabetical list of the subjects in a softcopy document and the topics in which each subject is found.  Contrast with table of 
 contents and search index.  See also Index navigator.
  
  

Index navigator .  A window that lists all the index entries in a softcopy document and lets you work with them.
  
  

information message .  A message that tells you that an operation has been performed successfully.  See also message, error 
 message, and warning message.
  
  

initial value .  Information present in a text box when that box is first displayed.  See also default.
  
  

insertion point .  The place where text will be inserted when you type. The insertion point usually appears as a flashing vertical bar in an 
 application's window or in a dialog box.  Also known as cursor.  (W)
  
  

installation .  The process of placing a software program on a computer's fixed disk.
  
  

integrated pictures .  Pictures that are either vector graphics or images, and which you can view within the Book window at the points at 
 which they occur in the text.  Contrast with picture link.  See also norunin image and runin image.
  
  

interactive processing .  A processing method in which each user action causes a response from the program or the system.
  
  

intra-document link .  A link that connects two document elements within the same softcopy document.  Contrast with cross-book link.  
 See hypertext link.  See also cross-reference link.
  
  
    +---+
    ¦ J  ¦
    +---+
  

jump .  Synonym for link.
  
  
    +---+
    ¦ K ¦
    +---+
  

K.  When referring to storage capacity, two to the tenth power, or 1024 in decimal notation.
  
  

keys help .  A type of help information that lists the default key assignments for a particular window.
  

keyword .  A significant and informative word that describes the content of a list of choices.
  
  
    +---+
    ¦ L ¦
    +---+
  

label .  A name assigned to each set of search matches found during the search of a book or topic.  The label initially assigned by 
 BookManager READ/2 is the first few words or phrases from the list of search words and phrases.
  

LAN .  Synonym for local area network (LAN).
  
  

LAN administrator .  A person responsible for setting up a local area network (LAN), determining the directory/subdirectory structure of 
 the LAN files, and maintaining the LAN.
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line scrolling .  Moving a display image vertically, causing the line containing the cursor to be positioned at the top or bottom of the 
 scrollable area.  See scrolling and scrolling area.
  
  

link .  (1) A connection between related pieces of information.  (2) To go to a related piece of information by activating the connection.  See 
 hypertext link, cross-reference link, and cross-book link.
  
  

link source .  An object from which a link is made.  A link source can be another place in the same book or a place in another book.  A link 
 source can be text or artwork.  Contrast with link target.
  
  

link target .  The object to which a link is made.  A link target can be another place in the same book or a place in another book.  A link 
 target can be text or artwork.  Contrast with link source.
  
  

list box .  Within an application window or dialog box, a type of box that lists available choices--for example, a list of all files in a directory. If 
 all the choices do not fit in the list box, there is a scroll bar. (W)
  
  

List of Books window .  A window which displays books found in the directories you have specified.  The books listed on this window do 
 not necessarily have to be in the same bookshelf.  Contrast with Bookshelf window.
  
  

List of Bookshelves window .  The first window that Library Reader for Windows displays, if you start it without specifying a particular 
 bookshelf or book.  This window lists all the bookshelves that can be found in your startup path.  You can open the bookshelves from this 
 window, or use the menus to do other Library Reader for Windows tasks. See also startup path.
  

list of figures .  See figure list.
  

list of tables .  See table list.
  
  

local area network (LAN) .  A network established in a limited area to permit sharing of common computer resources.
  
  

logo .  A letter, combination of letters, or symbol that identifies a product or company.
  
  

lowercase .  Pertaining to the small letters, as distinguished from the capital letters; for example, a, b, c rather than A, B, C.  Contrast with 
 uppercase.  See also Case-Sensitive.
  
  
    +---+
    ¦ M ¦
    +---+
  
  

margin .  (1) In Library Reader for Windows the unoccupied space between the left edge of the Book window and the start of the topic 
 text.  The margin of a softcopy book can contain note icons or revision characters. (2) A generally unprinted area that lies between the 
 text area of a page or screen and the edge of the page or screen.  Margins may contain small illustrations, notes, and page numbers.  A 
 rectangular page or screen therefore has four margins. (T)
  
  

mark .  To identify a section of text on which Library Reader for Windows is to perform some task, for example printing or copying.  An 
 area that is marked is displayed in reverse video.  Contrast with deselect.  See also reverse video.
  

markup tag .  The name for a type of document or document element entered into the document that is used to identify it, to define 
 information to be added to the content of the document to enable a person or system to process it, or to locate elements in the document.  
 See also document markup language.
  
  

match .  A word or phrase that is identical or similar to the words or phrases in a search request.
  
  

maximize .  To make a window as large as possible.  Contrast with minimize.
  
  

memory .  A temporary storage area for information and applications. (W) See also random access memory (RAM).
  
  

menu .  A list of available commands in an application window.  Menus are represented by their menu names, which appear in the menu 
 bar located just under the title bar of a window.  You open a menu by selecting the menu name.  See also menu bar and menu name.
  
  

menu bar .  The horizontal bar containing the names of the application's menus.  It appears below the title bar.  See also menu and menu 
 name.
  

menu choice .  Synonym for menu command.
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menu command .  One of the actions that is available from a menu.  Some menu commands are available only under certain conditions; 
 when unavailable, they appear to be grayed out.
  

menu item .  Synonym for menu command.
  
  

menu name .  A choice in a menu bar that represents a menu.  See also menu and menu bar.
  
  

message .  Information that the computer automatically generates and presents to you.  See error message, information message, and 
 warning message.
  
  

message area .  The area of a window in which Library Reader for Windows sometimes displays messages.  Contrast with message 
 window.
  
  

message help .  Online help information that describes the purpose, use, or contents of a computer message.  Contrast with contents 
 help, context-sensitive help, and short help.  See also message.
  
  

message window .  A window that appears when Library Reader for Windows displays a message of particular importance.  The text of 
 the message appears in the message window.  Contrast with message area.
  
  

minimize .  To reduce a window to an icon.  Contrast with maximize.
  

monospaced .  Pertaining to a type font that displays and prints each character at equal widths; for example, a w takes up the same 
 space as an i.
  
  

monospaced font .  A font in which all characters have uniform widths, such as Courier New. (W) Contrast with proportional font.  See 
 also font.
  
  

mouse .  A device you move on a flat surface to position a pointer on the screen.  A mouse lets you select a choice or function to be 
 performed or to perform an action on the screen, such as marking an area of text, or dragging an object.  A mouse generally contains a 
 control ball or a pair of wheels.
  
  

mouse button .  A mechanical button usually located on top of a mouse that you press to make selections on the screen or begin 
 computer actions.  See mouse button 1 and mouse button 2.
  
  

mouse button 1 .  Generally the button on a mouse located closest to the screen.  On a mouse operated with the right hand, it is usually 
 the left button.  On a mouse operated with the left hand, it is usually the right button.
  
  

mouse button 2 .  On a two-button mouse operated with the right hand, the right button.  On a two-button mouse operated with the left 
 hand, the left button.  On a three-button mouse, the middle button.
  
  

mouse pointer .  (1) The arrow-shaped cursor on the screen that follows the movement of a mouse (or other pointing device) and 
 indicates which area of the screen will be affected when you press the mouse button.  The pointer may change shape during certain 
 tasks. (W) See also mouse and mouse button.  (2) The symbol displayed on the screen, that is moved by a mouse. A mouse pointer is 
 used to select menu commands and icons (arrow), to indicate that an action is being processed (hourglass), or to size a window (double 
 arrow).
  

move .  A Windows action that lets you reposition a window.
  
  

multimedia .  A combination of various media, such as sound, graphics, animation, and video.  (W)
  
  

multiple-book search .  The same search performed in more than one book simultaneously.  It may be done in all or selected books in a 
 bookshelf or List of Books.  Search results are displayed in a Multiple-Book Search Results window.  Search matches are optionally 
 emphasized in the text of the book or books.  Contrast with book search.
  
  
    +---+
    ¦ N ¦
    +---+
  
  

navigate .  To locate and work with information in a book.
  

navigator .  Synonym for navigator windows.
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navigator windows .  Windows that help you find and go to information in a softcopy book.  In Library Reader for Windows the following 
 are navigator windows:  Topics, Search Results, Topics-Seen, Notes List, Revisions, Figures, Tables, and Index.
  
  

next topic match .  The first match in the next topic that has matches for a given search.  Contrast with previous topic match.
  
  

norunin image .  An image that appears on a line by itself, although it can have topic text above or beneath it.  Contrast with runin image.
  
  

note .  Additional information or comments that you attach to a line of text or an integrated picture in a softcopy document.  See notes file 
 and notes file path.
  
  

notes file .  A file in which Library Reader for Windows stores notes.  The notes file extension is usually .NTF.  See also notes file path 
 and note.
  
  

notes file path .  The path you specify using the Options - Startup Defaults window that tells Library Reader for Windows where to find 
 and store notes.  See also startup path and path.
  
  

numeric key pad .  The number keys, function keys, and direction keys at the far right side of the keyboard.
  
  
    +---+
    ¦ O ¦
    +---+
  
  

object .  Anything that you can focus attention on and manipulate as a single unit (for example, a book or a bookshelf).
  

online .  Connected to, served by, or available through, a system or computer.
  

online book .  Synonym for book.
  

online help .  Synonym for contents help.
  

online information .  Information stored in a computer system that can be displayed, used, and modified in an interactive manner without 
 any need to obtain hardcopy.
  
  

open .  (1) To retrieve and display a specific bookshelf, book, topic, note, or picture and display it in a window so that you can see its 
 contents.  (2) To open a second or subsequent alternative view of an already-open List of Bookshelves, List of Books, or bookshelf.
  

open a book .  See open.
  

open a bookshelf .  See open.
  
  

open book exit .  A user exit that enables a site to monitor when a softcopy document is opened.  Library Reader for Windows invokes 
 this exit whenever a book is being opened to be read in the Book window.  See also close book exit, search expansion exit, user exit, and 
 open a book.
  
  

open window .  A window that has been displayed and has not yet been closed.  An open window can be hidden from view temporarily by 
 other open windows.  See also active window and inactive window.
  
  

operator .  (1) A symbol that represents an operation to be done.  (2) In a search request, the lexical entity that indicates the action to be 
 performed on a word or phrase.
  
  

operating system .  An organized collection of programs that controls the overall operation of a computer.
  
  

Operating System/2 (OS/2) .  A family of IBM licensed program operating systems for most IBM Personal System/2 models, the IBM 
 Personal Computer AT, and the IBM Personal Computer XT Model 286.
  
  

option .  A choice in a dialog box. (W)
  
  

option .  In a DOS command line, a parameter used to control how a command is carried out.  Typically, an option starts with a slash (/). 
 (W)  See also startup options.
  
  

option button .  A small, round button that appears in a dialog box. Within a group of related option buttons, you can select only one. (W) 
 Also known as radio button.
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OR.  In Boolean searching, the relationship expressed by the | operator when used to connect two words or phrases in a search 
 request.  When connected by a OR relationship, at least one of the words or phrases in the search request must be present in the topic 
 for the topic to be considered a match.  Contrast with AND and BUT NOT.  See also |, Boolean, search request, and operator.
  
  

order of precedence .  The order of priority in which Library Reader for Windows processes Boolean operators in a search request.  The 
 default order of precedence is BUT NOT, AND, and then OR.  The order can be altered by putting parentheses (grouping operators) 
 around words or phrases in the search request.  The search first looks for the words or phrases connected by operators from the inside 
 of the innermost set of parentheses and proceeds out to the outermost set of parentheses.
  

OS/2.  Synonym for Operating System/2.
  
  
    +---+
    ¦ P ¦
    +---+
  
  

page down .  To display information below the information that is currently visible in a window.  Contrast with page up.  See also scroll.
  
  

page segment (PSEG) .  An object that can contain text and images and be included on any addressable point on a page.  Page 
 segments can be used to include artwork in softcopy.
  
  

page up .  To display information above the information that is currently visible in a window.  Contrast with page down.  See also scroll.
  

parameter .  Synonym for option.
  
  

paste .  To copy the contents of the Clipboard into an application.  Many applications have a Paste command on the Edit menu that 
 performs this task. (W)
  
  

path .  The storage location of a file.  The path includes the drive, directory, and, if applicable, the line of subdirectories leading to the 
 directory in which the file resides.  See startup path and notes file path.
  
  

permanent .  Fixed or unchanged; for example, a color setting that remains the same from one book session to another.
  
  

personal computer (PC) .  (1) A microcomputer primarily intended for stand-alone use by an individual. (T) (2) A desk-top, floor-standing, 
 or portable microcomputer that usually consists of a system unit, a display monitor, a keyboard, one or more floppy disks drives, internal 
 fixed-disk storage, and an optional printer.
  
  

Personal System/2 (PS/2) .  A family of IBM personal computer systems ranging from a low-price, general-purpose computer system 
 offering approximately two times the processor performance of 8088-based IBM Personal Computers up to high-performance systems 
 that support advanced multitasking and multiuser applications and network services.  The PS/2 is designed primarily for stand-alone 
 operation but may be connected to a mainframe or a network.
  
  

phrase .  In a Library Reader for Windows search request, a collection of two or more words treated as a unit.
  

phrase separator .  See word or phrase separator.
  
  

picture .  An illustration (image or graphic) in a softcopy document that can be displayed either integrated in topic text, or separately in a 
 Picture window.
  
  

picture element (pel) .  The smallest element of a display surface that can be independently assigned color and intensity. (T)
  
  

picture identifier .  A word or phrase in the text of a softcopy document that represents a piece of artwork, when the artwork is not 
 integrated in the topic text.  You can view the artwork in a Picture window by choosing its picture identifier.
  
  

picture link .  A highlighted set of words or characters that appearin Library Reader for Windows where a picture would normally occur in 
 a printed book.  Each picture link appears on a line by itself and consists of the word PICTURE followed by either a number or name.  To 
 view the picture, you click on the highlighted phrase.  Contrast with integrated picture.  See also norunin image and runin image.
  

pointer .  See mouse pointer.
  

pop-up window .  Synonym for dialog box.
  
  

previous link .  The location from which a hypertext link began, and to which you can return.
  
  

previous topic match .  The first match in the previous topic that has matches for a given search.  Contrast with next topic match.
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print .  To produce legible characters or other marks on paper or other media.
  
  

processor .  (1) In a computer, a functional unit that interprets and executes instructions.  A processor consists of at least an instruction 
 control unit and an arithmetic and logic unit. (T) (2) The functional unit that interprets and executes instructions.
  
  

profile .  A file containing default options or options that you specified to tell Library Reader for Windows functions how to operate.  See 
 also startup options.
  
  

program-item icon .  The icon that represents the Library Reader for Windows application in the BookManager Library Reader for 
 Windows group window in Microsoft Windows Program Manager.  You can start the Library Reader for Windows application by choosing 
 its program-item icon.  See also application, icons, group window, and choose.
  
  

programmable workstation .  A workstation that has some degree of processing capability and that lets you change its functions.
  

programming interface .  Synonym for user exit.
  

prompt .  See DOS prompt.
  
  

proportional font .  A font in which different characters have varying widths, such as Times New Roman. (W) Contrast with proportional 
 font.  See also font.
  

PSEG.  See page segment (PSEG).
  

PS/2.  Synonym for Personal System/2.
  

pull-down menu .  Synonym for menu.
  
  
    +---+
    ¦ Q ¦
    +---+
  

question mark .  Synonym for ?.
  
  

quick tour .  A subset of topics in the softcopy and hardcopy IBM BookManager Library Reader for Windows User Guide that provides a 
 high-level, conceptual introduction to Library Reader for Windows, and the methodology for reading only those topics.  In softcopy the 
 quick tour consists of a series of links from one tour topic to the next; in hardcopy it consists of page references--identified by a tour bus 
 icon--to topics that are tour stops.
  
  
    +---+
    ¦ R ¦
    +---+
  

radio button .  Synonym for option button.
  

RAM .  Random access memory.
  
  

random access memory (RAM) .  The memory that can be used by applications to perform necessary tasks while the computer is on.  
 When you turn the computer off, all information in RAM is lost. (W) Contrast with disk.
  

ranking .  See search ranking.
  
  

raster image .  A type of computer graphics in which a display image is composed of an array of picture elements (pixels) arranged in 
 rows and columns.  Contrast with vector graphic.
  
  

Library Reader for Windows session .  (1) The period of time between starting Library Reader for Windows and exiting it.  (2) The 
 period of time during which the List of Bookshelves window is open.  (3) If you start Library Reader for Windows by opening directly to a 
 bookshelf or book, the period of time during which that bookshelf or book is open.  See also book session.
  
  

read-only access .  A type of access that allows data to be read but not modified.  Contrast with read/write access.
  
  

read/write access .  A type of access that lets you get information from and put information into a file.  Contrast with read-only access.
  
  

reboot .  To restart the execution of a program or operating system.  On a workstation you typically reboot by pressing CTRL+ALT+DEL, 
 or by powering off and then on again.
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reference .  Synonym for cross-reference link.
  
  

reference phrase help .  Additional information about user-selectable words or phrases within a help window.
  
  

reflow .  The ability to wrap lines of text within existing margins by splitting lines between words.
  
  

reflowable text .  A document element identified by BookManager BUILD 1.3 as having the ability to adjust line widths to fit within existing 
 margins after, for example, changing a font size or window size.  Paragraphs and list items are examples of reflowable document 
 elements.
  
  

refresh .  To update the information that you are currently viewing.
  
  

remove .  To remove a book from a bookshelf.  This action does not physically delete the book from disk storage, but only erases the 
 book's name from the bookshelf list.
  
  

replace .  To substitute one item for another; for example, to substitute or overstrike a character or space with another character.
  
  

resize a picture .  To change the dimensions of a piece of artwork.
  
  

resource sharing .  (1) In word processing, an arrangement in which two or more workstations share common facilities. (T) (2) 
 Directories, data files, programs, printers, plotters, and serial devices (such as modems) made available to users on a network.  Users 
 access these resources from their own computer or workstation.  See also share mode.
  

reversed image .  Synonym for reverse video.
  
  

reverse video .  A method of highlighting text by reversing the color of the characters with the color of the background.  For example, in a 
 window using black characters on a white background, reverse video text would use white characters on a black background.
  
  

review notes .  To look at only those topics that have notes attached.
  
  

review revisions .  To look at only those topics that have been changed or added to a book.
  
  

review topics .  To look at, in reverse order, only those topics that you have already seen.
  
  

revision character .  A character in the margin, such as a bar (|), that indicates that the text line beside it has been changed by the author.
  

revision code .  Synonym for revision character.
  

revision symbol .  Synonym for revision character.
  
  

revisions .  Changes an author has made to a book.  Revisions may be marked with revision characters.  Readers can move through a 
 book looking at only those topics that have been changed or added to the book.  See also revision character and navigator windows.
  
  

Revisions navigator .  A window that lists only the topics in a softcopy document that contain revision characters.  See also revision 
 character and navigator windows.
  
  

root directory .  The top-level directory of a disk.  The root directory is created when you format the disk.  From the root directory, you 
 can create files and other directories. (W)
  
  

runin image .  In hardcopy, a picture with topic text on one or both sides. Contrast with norunin image.
  
  
    +---+
    ¦ S ¦
    +---+
  
  

scan .  Using a scanner device to convert a paper picture to computer image form.  See also scanner.
  
  

scanner .  A device that produces a computer image from a picture on a piece of paper.
  
  

screen .  The physical surface of a display device upon which information is shown to you.  See also window.
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scroll .  To move a display image vertically or horizontally to view data that is not otherwise visible in a window.  See also page up and page 
 down.
  
  

scroll arrow .  An arrow on either end of a scroll bar that you use to scroll through the contents of the window or list box. (W)
  
  

scroll bar .  A bar that appears at the bottom and/or right edge of a window whose contents are not entirely visible.  Each scroll bar 
 contains a scroll box and two scroll arrows. (W)
  
  

scroll box .  In a scroll bar, the small box that shows the position of information currently in the window or list box relative to the contents 
 of the entire window. (W)
  
  

scrolling .  To scroll information within a window and from window to window within a book.
  
  

scrolling area .  Specific places on the window that can be scrolled.
  
  

search .  A powerful Library Reader for Windows function that lets you locate specified words and phrases within multiple books on a 
 bookshelf, a single book, or selected topics.  When the search is complete, any words or phrases that match the specified words or 
 phrases are emphasized in the text of the book or are presented in a Search Results or a Multiple-Book Search Results window.
  
  

search emphasis .  Color or intensity that makes search matches stand out from the rest of the text in a softcopy document.
  
  

search expansion exit .  A user exit that enables a site to modify Library Reader for Windows search requests before the searches are 
 performed. This exit allows a site to expand a search request, supply its own synonyms, or monitor search invocation to meet its own 
 needs.  The site can use any facility it chooses to modify the search request.  Library Reader for Windows uses the modified search 
 request as if it had generated it.  See also open book exit, close book exit, user exit, and search request.
  
  

search index .  An index of all information in the books on a bookshelf, created with BookManager BUILD or BookManager READ on a 
 host computer. The search index is usually created as a file that has the same name as the bookshelf, and an extension of .BKI.  Using a 
 search index can make searching the books in a bookshelf significantly faster.
  
  

search options .  In Library Reader for Windows, the options you can set to specify which type of search dialog box is to appear; what 
 areas of the book to search; what type of search to do; and how to show results.  See also focused search.
  
  

search match .  A word or phrase containing information that matches the words specified in a search request.  See also search request.
  
  

search ranking .  The method Library Reader for Windows uses to organize search matches.  For a single-book search, the topics with 
 the best matching information are ranked highest.  For a multiple-book search, the books with the best matching information are ranked 
 highest.
  
  

search request .  The words and phrases that you want Library Reader for Windows to locate in a book or bookshelf.  A single search 
 request can include any combination of words, phrases, spaces, and operators as long as it does not exceed 255 characters.
  
  

search results .  (1) In a single-book search, a list a topics that contain one or more search matches.  See also search match.  (2) In a 
 multiple-book search, a list of books whose topics contain one or more search matches.
  
  

search results importance .  A method of ordering search results based on factors such as closeness of the match, location of 
 matches, and the number of matches in a topic.  This method arranges entries with search matches in order of probable importance, so 
 that the ones most likely to be helpful are listed first.
  
  

Search Results navigator .  A window that lists only the topics containing search matches.  From this window you can display the first 
 search match in each topic in the context of its surrounding text on the same line, or you can go to the search match in the topic text.  See 
 also search request, search match, exact match, and fuzzy match.
  
  

select .  To mark an item so that a subsequent action can be carried out on that item.  You usually select an item by clicking it with a 
 mouse or pressing a key.  After selecting an item, you choose the action that you want to affect the item. (W)  Contrast with choose.
  
  

selection .  The act of explicitly identifying one or more objects to which a subsequent action will apply.
  
  

selection cursor .  The marking device that shows where you are in a window, menu, or dialog box and what you have selected.  The 
 selection cursor can appear as a highlight or as a dotted rectangle around text. (W) See also select.
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separating operator .  A character or symbol, such as a comma in Library Reader for Windows, that separates words and phrases into 
 single search requests.  See also search request.
  
  

sequence .  An arrangement of items according to a specified set of rules; for example, items arranged alphabetically, numerically, or 
 chronologically. (A)
  
  

session .  The period of time that begins when you starts a program or open an object, and ends when you end the program or close the 
 object.  See Library Reader for Windows session and book session.
  
  

share mode .  In Library Reader for Windows, a DOS mode of operation that permits sharing of such resources as files, directories, and 
 printers. See also resource sharing.
  
  

short help .  A one-line description of a menu command or tool bar icon. Contrast with contents help and context-sensitive help See also 
 click.
  
  

shortcut key .  A key or key combination that you press to carry out a command or action.  If a command has a shortcut key, the key 
 combination is listed to the right of the command name on the menu.  For example, pressing the shortcut key Alt+F4 closes the active 
 application. (W)
  

size .  To make a window larger or smaller by moving its vertical and horizontal borders.
  

slider box .  A window component that indicates the position and size of the visible information in relation to the total amount of information 
 available.  The information can be scrolled by dragging on the box or clicking on the darkened arrow.
  
  

softcopy .  Online information that can be electronically distributed, manipulated, and printed.  Contrast with hardcopy.
  
  

sort .  (1) To arrange a set of items to be used in a specified sequence, such as alphabetic or numeric.  (2) To arrange a set of items 
 according to keys used as a basis for determining the sequence of items; for example, to arrange the records of a personnel file in 
 alphabetical sequence by using the employee names as sort keys. (A) See also sequence.
  
  

source file .  An input file that contains either text and formatting instructions (for example, markup tags or word-processor formatting 
 codes) or pictures for use for use with BookManager BUILD.  The same input files can be used create softcopy or to print hardcopy.
  
  

special character(s) .  Characters not part of the regular alphabet.
  
  

split bar .  Divides a window into two parts. (W)
  
  

startup options .  Options you can append to the READIBM command to start the Library Reader for Windows application in a variety of 
 different ways.
  
  

startup path .  The path you specify using the Options - Startup Defaults window that tells Library Reader for Windows  where to find 
 bookshelves and books when it starts up.  See also notes file path and path.
  
  

status area .  The window area that displays the topic heading, security information, and copyright information for the current topic in the 
 Book window.
  
  

status bar .  A line of information usually located at the bottom of a window. (W)
  
  

subdirectory .  A directory within another directory. (W)
  
  

subtopic .  A topic that is subordinate to a higher-level topic.  For example, 2.1 and 2.2 are subtopics of topic 2.0.
  
  
    +---+
    ¦ T ¦
    +---+
  
  

tab .  A typing action that moves the selection cursor to the beginning of the next text box, list box, check box, or group of option buttons.
  
  

Tab key .  A key that causes tabbing to occur.  See also tab.
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table .  Information presented in rows and columns and defined by the author as a table.

  
  

table list .  A list of all numbered tables contained in a book.
  
  

table of contents .  A list of topics in the order in which they appear in a book.  Contrast with index.
  

TABLES .  The topic ID of a topic in a softcopy document that contains the list of tables in the book.
  
  

Tables navigator .  A window that lists the tables in a softcopy document and lets you work with them.
  
  

target .  See link target.
  
  

Task List .  A window that shows all the applications you have running and enables you to switch between them.  You can open the Task 
 List by choosing Switch To from the Control menu or by pressing Ctrl+Esc. (W)
  
  

temporary .  Not permanent; for example, a tool bar setting that ends with the current book session.
  
  

text .  A graphic representation of information on an output medium.  Text can consist of alphanumeric characters and symbols arranged 
 in paragraphs, tables, columns, or other shapes.  Contrast with graphic and raster image.
  
  

text box .  In a dialog box, a box in which you type information needed to carry out a command.  The text box may be blank or may contain 
 text when the dialog box opens. (W)  Contrast with list box.
  

text cursor .  A symbol displayed in a text box that shows you where information you type, or paste from the Clipboard, will appear.  
 Synonym for insertion point.
  
  

title bar .  The horizontal bar (at the top of a window) that contains the title of the window or dialog box.  On many windows, the title bar 
 also contains the Control-menu box and Maximize and Minimize buttons. (W)
  
  

topic .  A heading and its subsequent text up to the next heading; the basic unit of information in a Library Reader for Windows softcopy 
 document.
  
  

topic heading .  A heading that introduces each new topic in softcopy. Each topic heading is made up of two parts: a topic ID and a topic 
 title. See topic identifier and topic title.
  
  

topic ID .  See topic identifier.
  
  

topic identifier .  A unique number or name that identifies each topic in softcopy.  A topic identifier is part of a topic heading.  Topic 
 Identifiers are similar to the page numbers that appear in a hardcopy document.  See also topic and topic heading.
  

topic number .  Synonym for topic identifier.
  
  

topic text scroll bar .  A bar that appears at the right edge of the left side of the Book window and that can be used to scroll the topic text 
 vertically.  See also  scroll bar, and horizontal topic text scroll bar.
  
  

Topics navigator .  A window that lists all the topics in a softcopy document that have topic IDs, and lets you work with them.
  
  

Topics-Seen navigator .  A window that lists the topics that have been displayed during the book session.
  
  

topic title .  The title that is associated with a topic heading.  See also topic.
  

topics list .  The list of all the topics in a softcopy document that have topic IDs.  This list appears in the right half of the Book window, or in 
 the Topics navigator window, or in both places.
  
  
    +---+
    ¦ U ¦
    +---+
  
  

unavailable choice .  A command in a menu that you cannot choose due to the state or condition of the items in the window, the window 
 itself, or the Library Reader for Windows application.  For example, menu commands that apply an action to a book or bookshelf are 
 unavailable if no book or bookshelf has been selected.  An unavailable choice is dimmed.  Contrast with available choice.  See also 
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 dimmed.
  
  

underscore .  A line placed under a character.
  
  

Unicode .  See universal code page.
  
  

universal code page .  (1) A character encoding standard consisting of a 16-bit width, uniform text encoding scheme.  (2) Defines codes 
 for characters used in every major language of the world.
  
  

unlink .  To return to the location in topic text where a you selected a hypertext link (the link source).  See link source.
  

up .  See page up.
  
  

upload .  To transfer data from a device such as a workstation or microcomputer to a mainframe computer.  Contrast with download.
  
  

uppercase .  Pertaining to capital letters, as distinguished from lowercase letters; for example, A, B, C rather than a, b, c.  Contrast with 
 lowercase.
  
  

user exit .  A point in an IBM-supplied program at which a user-written routine can take control.
  
  

user profile .  Information that Library Reader for Windows saves about your preferences for colors, fonts, paths, search options, 
 workspace options, and confirmation options.
  
  
    +---+
    ¦ V ¦
    +---+
  
  

validation .  The checking of data for correctness or for compliance with applicable standards, rules, and conventions. (A)
  
  

variations .  Words in the softcopy book that are similar in spelling to a word entered in a search request.
  
  

vector graphic .  Computer graphics in which display images are generated from display commands and coordinate data. (I) (A) Contrast 
 with raster image.
  

vertical bar .  See OR.
  
  
    +---+
    ¦ W ¦
    +---+
  
  

warning message .  Information provided by a computer to indicate a possible error condition.  A warning message also tells you that to 
 perform the action you are requesting can cause an undesirable condition. You may be required to confirm the action or take other steps.  
 See also message, information message, and error message.
  
  

wildcard .  The character used to substitute for unknown or unspecified characters or words in a search word or phrase.  An asterisk (*) 
 is an example of a wildcard character.
  

wildcard character .  Synonym for wildcard.
  
  

window .  A rectangular area on your screen in which you view an application or document.  You can open, close, and move windows, and 
 change the size of most windows.  You can open several windows at a time, and you can often reduce a window to an icon or enlarge it to 
 fill the entire desktop.  Sometimes windows are displayed within other windows. (W) See also dialog box, icons, desktop, and screen.
  
  

word .  For the purpose of a Library Reader for Windows search, a character string that is considered as a unit and does not exceed 60 
 characters.
  
  

word check .  In searching, a function that allows you to locate a word in the book or bookshelf that is similar a word in your search 
 request.  For example, after selecting Word Check for the word birth  in your search request, Library Reader for Windows could present 
 you with birthdate as a variation that you could search for instead.
  
  

word or phrase separator .  A special character used in a search request to separate different words or phrases.  For example, the 
 search request conduct, behavior uses a comma as the separator to tell Library Reader for Windows to search for the word "conduct" 
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 and the word "behavior."
  
  

workspace .  The area of a window that displays the information contained in the application or document you are working with. (W)
  

workstation .  One or more programmable or nonprogrammable devices that let you work on a computer.
  
  
    +---+
    ¦ Z ¦
    +---+
  
  

zoom in .  To enlarge a selected portion of a picture.
  
  

zoom out .  To reduce in size a portion of a picture that has been enlarged.
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 COMMENTS Readers' Comments -- We'd Like to Hear fro m You
IBM BookManager Library Reader for Windows(TM) Online Reference

  
 Version 2 Release 0
  
 Publication No. SC34-3066-00
  
  

We hope you find this publication useful, readable, and technically accurate, but only you can tell us!  Your comments and suggestions will 
 help us improve our technical publications.  Please take a few minutes to let us know what you think by completing this form and returning 
 it to IBM at the address provided.  You may also return this form by fax to (919) 469-7718.
  
                                                              Yes     No
 *  Does the publication meet your needs?                     ___    ___
  
 *  Did you find the information:
        Accurate?                                             ___    ___
        Complete?                                             ___    ___
        Easy to find?                                         ___    ___
        Easy to understand?                                   ___    ___
        Well organized?                                       ___    ___
  

Please use the following space to share with us any further thoughts you have about this manual.  If you have found errors in it, or if you 
 want to express your opinion about it or make suggestions for improvement, let us know.
  
  
  
  
  

We also want your comments about BookManager.  Please use the following space to tell us what you like about the product or what we 
 can do to make BookManager better.
  
  
  
  
  

Thank you for your response.  When you send information to IBM, you grant IBM the right to use or distribute the information without 
 incurring any obligation to you.  Of course, you retain the right to use the information you supply.
  

Be sure to print your name and address below if you would like a reply.
  

Address your comments to:
  
     International Business Machines Corporation
     Information Development
     Department T45
     P.O. Box 60000
     Cary, NC  27511-8519
  
  
  
  
 Name   . . . . . . . . . __________________________ _____________________
 Company or Organization  __________________________ _____________________
 Address  . . . . . . . . __________________________ _____________________
                          __________________________ _____________________
                          __________________________ _____________________
 Phone No.  . . . . . . . __________________________ _____________________
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